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Chapter 2. Ennov InSight 7.3 Release Notes

Ennov InSight 7.3 Release Notes
The Release Notes contain information about updated files, new functionality, resolved issues, and any open issues 

or workarounds in this release of Ennov InSight 7.3.

The details in these Release Notes supersede all similar details that appear anywhere else in this release of the 

product or its other documentation.

Note:   Unless stated otherwise, this release provides the same functionality and regulatory updates as Ennov InSight 

7.2.7.

eCTD 4.0

Ennov InSight introduces a new functionality to maintain a new eCTD 4.0 standard that contains a new harmonized 

submission unit, updated document reuse capability, and context of use life cycle. For full details, see Ennov InSight 

7.3 Publishing: eCTD 4.0.  The high level list of updates is below:

— The creation and maintenance of eCTD 4.0 submissions structure across the life cycle of the application. — 

The Create, Read, Update and Delete (CRUD) operation on eCTD 4.0 assembly as well as its nodes. — Electronic 

publishing related functionality updated.

— Changes to the following:

• assembly, folders, leaf attributes

• publishing settings library

• prepare to publish

• publish request

— Priority number management — New Modified Leaf field view

— Ability to quickly and easily incorporate regulatory agencies provided controlled vocabularies for future eCTD 4.0 

specification updates.

— The XML import and export of eCTD 4.0 assemblies.

— Setting and reflecting priority for siblings under one parent.

— Context of Use definition for specified elements: Group titles, study group orders supported according to Health 

Authority specifications.

— New Regional Information page for eCTD 4.0 assembly root and Additional Information page for eCTD

4.0 assembly folder to set up Context of Use attributes and assembly regional attributes.

— The applicant contact type has been updated in Data Administration for eCTD 4.0.

https://help.liquent.com/CalyxRIM_7.3/Publishing_eCTD_40/index.html
https://help.liquent.com/CalyxRIM_7.3/Publishing_eCTD_40/index.html
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— Applicant contact maintenance for eCTD 4.0.

— Same document reuse in several places.

— Sender-defined keywords maintenance to get better quality of the data entered.

— Tracking the long-running processes in Job Requests:

• Add Assembly to Lifecycle

• Remove Assembly from Lifecycle

• Duplicate (of large folder)

• Creating assembly

— Process of duplicating a folder. If the number of folder and child nodes exceeds the allowed limit, using the 

Duplicate option displays a message to see Job Requests for the status.

— Process of creating an assembly from another assembly. If the number of folder and child nodes exceeds the 

allowed limit, a message to see Job Requests for the status is displayed.

— Performance improvement. Duplicating folder with documents takes less time now.

Entity and Tabs Changes

To conform to the eCTD 4.0 requirements, changes have been made to the following entities: See: Entity Fields and 

Columns Added: Ennov InSight 7.3, Entity Fields and Columns Updated: Ennov InSight 7.3

— Entities:

• Application updates (Application Attributes, Sender-defined Keywords).

• Sequence updates (Sequence Attributes).

• Wizards updates.

• Product Family updates (Product Family Attributes, Application tab).

• Data Administration updates.

IDMP Updates

For full details, see Ennov InSight 7.3 IDMP. The high level list of updates is below:

Note:

— IDMP Data Generation, IDMP Data Visualization, IDMP Validation in Job Requests and FHIR message are 

implemented as Proof of Concept (POC). They will be expanded with additional functionality and features in the next 

releases of Ennov InSight .

— Current IDMP Data Generation, IDMP Data Visualization, IDMP Validation in Job Request and FHIR message are 

for EMA authority only. This IDMP functionality will be expanded for other authorities in the next releases.

https://help.liquent.com/CalyxRIM_7.3/IDMP/GUID-5017E7CB-721F-4AC5-B545-782249A2BF45.html
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— The final implementation of IDMP Data Generation and Data Visualization will be available in future Ennov InSight 

releases.

When available, remember to restart the IDMP Data Generation wizard for each medicinal product action entity to get 

the results for the IDMP Data Visualization page and validation messages in Job Requests.

To maintain a standardized and structured method of collecting, reporting, coding, and evaluating authorized 

medicinal product data, Ennov InSight 7.3 includes updates to the following:

— Entities:

• Medicinal Product Action (Attached Documents) updates.

• Manufactured Item (under Components) updates.

• PDS (Medical Devices, Package Set, Intended Effect/Comorbidity) updates.

• Data Administration updates.

• Security Administration updates. — IDMP Data Visualization:

• The DV (Data Visualization) icon is now available on the Medicinal Product Actions Attributes  page.

• Data Visualization includes the color coding. — Wizards:

• IDMP Data Generation wizard

• Ennov InSight now generates data in FHIR (Fast Healthcare Interoperability Resources) standard. Ennov 

InSight supports FHIR version 5.0.

— Versioning:

• Updates to IDMP entities are now tracked in versions.

— Job Requests updates for IDMP Data Generation in Job Requests > Search Results.

Referentials Management Services (RMS) for IDMP

The Referentials Management Services (RMS) updates for entities and Data Administration are introduced to capture 

additional RMS data for IDMP. The RMS for IDMP includes description for attributes of medicinal products, such as 

lists of dosage forms, units of measurement and routes of administration.

XEVMPD Submission Wizard

In Ennov InSight 7.3, some XEVMPD Submission wizard sections were removed to conform to the EMA specification 

for XEVMPD. Regulatory Updates

To support the Structured Product Labeling (SPL) for Risk Evaluation and Mitigation Strategies (REMS) in the US for 

eCTD 3.3, the US 3.3 assembly template is updated to include additional folders and leafs.

Assembly Updates
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Ennov InSight introduces the ability to track the download process of big files in Job Requests. When clicking View 

File and the file size exceeds the limit, the message is displayed asking to check the Job Requests for a download 

status.

Ennov InSight now displays the job progress in Job Requests for the following:

— Downloading of large files. If the file size exceeds the allowed limit, using the View File option displays a message 

to see Job Requests for download status.

Performance Improvements

The performance related to application and products query reports is improved.

Substance Search

The improved Substance Search  selection widget included for the following entities allows you to search for a 

substance to associate it with an entity. You can search by EV Code and Substance name. — Product Family

— Product (Component > Reference Active Ingredient)

— Manufactured Item (Component> Manufactured Item> Substance and Reference Substance)

— Comparator

— Pharmaceutical Product (Substance and Reference Substance)

— Product Detail Set and Product Detail Set Template (Substance and Reference Strain)

— Data Administration (Manufacturer Values > Global Product Details, Other > Certificate Master File Values) — 

Wizards (GPP > Update Product Detail Sets)

See: Get Started with Ennov InSight 7.3 > Substance Search. Functionality and Technology Not Supported

In preparation to capture Substance Management Services (SMS) data for IDMP, the framework was implemented 

in earlier Ennov InSight releases. The SPOR Master List for Substance is empty as EMA has not released the 

Substances

(SMS) controlled vocabulary. The Term ID value for the new Substance Search  selection widget will not be available 

in this release.

The following functionality is not available for eCTD 4.0 but will be included in future releases:

— Create eCTD 4.0 Assembly from: Submitted view, virtual document.

— Export to Microsoft Excel spreadsheet and Documentum virtual document (sometimes known as a compound 

document, depending on the repository type).

— Create eCTD wizard

— Recalculate Checksums
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— Change Submittal Status wizard

— Create Study Reports wizard

— Linking activities

— Forward compatibility

— Grouped submissions

— Parallel submissions

— Applicant Contact lifecycle

— PDF Properties management

— Publishing variables defined in leafs or folders.

— Virtual Document and Veeva Binder assignment

— eCTD Import

— Submission Validation

— eCTD 4.0 Viewing — Workflows

The following functionality is deprecated in eCTD 4.0 and will not be included in future releases:

— View Baseline Differences report

— Related Documents

— Create Version

— Publishing Summary Query

— Export Published Output

— Append lifecycle operation

— Paper Publishing

— Publishing assembly view

— Standalone assemblies

— Assembly versions

— Publishing elements

— The Change Type option for folder elements
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— The eCTD Lock option

Data Administration Lists - APIs CUD Operations

Ennov InSight 7.3 now includes the API Create, Update, Deactivate (CUD) operations for all Data Administration 

entities. See: Ennov InSight Administration > Technical Administration and Ennov InSight API Documentation.

DaaS Updates

Ennov InSight 7.3 includes updated DaaS database schema. See: Ennov InSight 7.3 DaaS DatabaseTables Changed.

New in Ennov InSight 7.3: Common Functionality

This table shows new features and enhancements of Ennov InSight 7.3 functionality.

eCTD 4.0

To maintain a new eCTD 4.0 standard.

Affected Area Update Benefit

Entities/Entity tabs
Changes for eCTD 4.0 now include:

— Entity updates:

• Application updates. See: Entity 

Fields and Columns Added: Ennov 

InSight 7.3, Registrations >

Application > Application

Attributes  and Registrations > Application > 

Sender-defined Keywords.

• Sequence updates. See: Entity Fields 

and Columns Added: Ennov InSight 

7.3, and Registrations > Sequence 

Attributes .

• The Dose Form Search  selection 

widget is implemented for more enti­

ties

The ability to separate differ­

ent submission standards 

and use the functionality de­

fined by the selected stan­

dard.

Affected Area Update Benefit
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Data Administration
To conform to eCTD 4.0 requirements, the 

following updates have been made to Data 

Administration:

— New CV Profile Values  table in Data

Administration > eCTD 4.0 Submission Main­

tenance.

— New Sender-defined Keyword Values  ta­

ble in Data Administration > eCTD 4.0 Sub­

mission Maintenance.

— Updated Applicant Contact Type Values 

table in Data Administration >

Submission Maintenance

— Updated Applicant Contact Values  table in 

Data Administration >

Submission Maintenance

To conform to eCTD 4.0 re­

quirements, new attributes 

are added to Data Adminis­

tration.

IDMP  To maintain IDMP updates:

Affected Area Update Benefit

Entities/Entity tabs
IDMP updates include:

— Attached Document updates. See Entity 

Fields and Columns Added:

Ennov InSight 7.3, Entity Fields and Columns 

Updated: Ennov InSight 7.3

— Manufactured Item updates. See:

Entity Fields and Columns Added: Ennov 

InSight 7.3

To conform to the latest 

IDMP specification, new at­

tributes are added to the enti­

ties and some existing attrib­

utes are updated.

Affected Area Update Benefit

Data Administration
IDMP updates include:

— New Data Administration Tables. See:

To conform to the latest 

IDMP specification, new at­

tributes are added to the Da­

ta Administration.
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Data Administration Tables Added: Ennov 

InSight 7.3:

• Device Classification Values  table in 

Medical Device Maintenance.

• Source of Information Values  table in 

Other

• Regulatory Entitlement Status

Values table in Application Maintenance.

• Tables in SPOR Master Lists: ■  Con­

tainer Category

■  eCTD EU Context of Use

■  Medical Device Classification

■  Medical Device Legislative

Category

■  Medicinal Product Type

■  Medicine Profile

■  Regulating Authority Submission

Unit Type

■  Source of Information

— Updated Data Administration Tables. See: 

Data Administration Tables Updated: Ennov 

InSight 7.3:

• Product Detail Set Maintenance > 

Сomponent  Type Values

• Product Detail Set Maintenance >

Device -Type of Combination Values

• Product Detail Set Maintenance > In­

tended Effect Values

• Registration Maintenance > Data Car­

rier Type Values.
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• Product Detail Set Maintenance > 

Substance Type Values

• Other > Attached Document Content 

Type Values

• Registration Maintenance > Registra­

tion Status Values

— Removed Data Administration Tables.

See: Data Administration Tables

Removed: Ennov InSight 7.3

©Ennov 2024
• Application Maintenance >

Product Information Document7 Enno

Type Values

v InSight RIM 7.3 Release 

Notes Cumulative

Ennov Ennov InSight 7.3 Release 

Notes

Affected Area Update Benefit

Security Administration Updated Security Administration Tables. 

See: Security Administration Tables Updat­

ed: Ennov InSight 7.3.

To support user's business 

flow of usage xEVMPD and 

IDMP.

Entity Updates  To conform the application updates to simplify data creation:

Affected Area Update Benefit

Entities/Entity tabs
Entity updates include the improved Sub­

stance Search  selection widget implement­

ed. See: Entity Fields, Columns and Options 

Updated: Ennov

InSight 7.3

— Product Family Attributes

— Comparator Attributes

— Product Detail Set Attributes >

Substances Properties > Add Substance

Improved selection widget 

capabilities with the updated 

data model enables simpli­

fied data creation.
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— Product Detail Set Template

Attributes > Substances Properties > Add 

Substance

— Product Detail Set Attributes > Active In­

gredients > Active Ingredient Detail

Attributes > Flu Strain Attributes >

Add Reference Strain

— Product Detail Set Template Attributes > 

Active Ingredients >

Active Ingredient Detail Attributes >

Flu Strain Attributes > Add Reference Strain

— Component Attributes > Active Ingredients 

> Reference Active

Ingredient > Create Reference Active Ingredi­

ent

— Сomponent  Attributes >

Manufactured Items > Substances >

Create Substance

— Сomponent  Attributes >

Manufactured Items > Substances >

Reference Substances > Create

Reference Substance

— Pharmaceutical Product Attributes > Sub­

stances > Create Substance

— Pharmaceutical Product Attributes > Sub­

stances > Reference Substances

> Create Reference Substance

Affected Area Update Benefit
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Data Administration
Updates include the Substance Search  se­

lection widget implemented. See: Data Ad­

ministration Tables Updated:

Ennov InSight 7.3

— Manufacturer Values > Global

Product Details

— Other > Certificate Master File Values

Improved selection widget 

capabilities with the updated 

data model enables simpli­

fied data creation.

Affected Area Update Benefit

Create

Application

Wizard

The Create Application  wizard is updated with the new fields 

when creating a sequence. See: Entity Fields and Columns 

Added: Ennov InSight 7.3

To maintain a new controlled vo­

cabularies for quick and easy 

eCTD 4.0 specification updates 

in future, the sequence and other 

related submission options up­

dates are introduced.

Product Detail Set

Affected Area Update Benefit

Entities/Entity tabs
IDMP updates include:

— Entity updates:

• Product Details Set. See: Entity Fields and 

Columns Added: Ennov

InSight 7.3, Entity Fields and

Columns Updated: Ennov InSight

7.3, Entity Fields and Columns

Deleted: Ennov InSight 7.3, Ennov InSight 

7.3 Registrations > PDS >

Product Details in PDS > Intended

Effect / Comorbidity sub-node

The ability to track intended 

effects/ comorbidities for the 

specific Indication and coun­

tries that are listed on the 

Indication/ Intended Use At­

tributes  page.
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New in Ennov InSight 7.3: Registrations

The new features and enhancements for Registration functionality are as follows.

Affected Area Update Benefit

Global Project 

Plan Wizard

The Global Project Plan  wizard is updated with new fields 

when creating a sequence. See: Entity Fields and Columns 

Added: Ennov InSight 7.3

To maintain a new controlled vo­

cabularies for quick and easy 

eCTD 4.0 specification updates 

in future, the sequence and other 

related submission options up­

dates are introduced.

The Global Project Plan  wizard is updated with improved 

selection widget when creating active ingredients and sub­

stances. See: Entity Fields and Columns Updated: Ennov 

InSight 7.3

Improved selection widget capa­

bilities with the updated

data model enables simplified 

data creation.

Product Detail 

Sets (PDS)
To include the changes for IDMP, additional attributes and 

updates are made for the following:

— Medical Devices:

• Medical Device > Medical Device Detail Attributes

— PDS Package Set:

• Packaging > Package Detail Attributes

• Pack Size > Pack Size Detail Attributes

See:

— Entity Fields and Columns Added: Ennov InSight

7.3

— Ennov InSight Registrations > PDS Page:

• Medical Device PDS Attributes

• Package Detail Attributes

• Pack Size Detail Attributes

The ability to capture IDMP da­

ta in Ennov InSight in prepara­

tion for submitting IDMP data to 

EMA.

Affected Area Update Benefit
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Medicinal

Product

Actions

Changes to IDMP also include updates for the following:

— Medicinal Product Actions Attributes:

• New DV icon is added.

See:

— Entity Fields and Columns Added: Ennov InSight

7.3

— Ennov InSight for IDMP > IDMP Data Visualization

— Ennov InSight for IDMP > IDMP Data

Visualization> Сolor  Coding  — Attached Document Attribut­

es.

See:

— Entity Fields and Columns Removed: Ennov InSight

7.3

— Entity Fields and Columns Updated: Ennov InSight

7.3

— Ennov InSight Registrations > Attached Document > At­

tached Document Attributes

The ability to capture IDMP da­

ta in Ennov InSight in prepara­

tion for submitting IDMP data to 

EMA.

Product Detail 

Sets (PDS)
Changes to IDMP also include the new Intended Effect/Co­

morbidity sub-node in the Product Details in a PDS  window. 

See:

— Entity Fields and Columns Added: Ennov InSight

7.3

— Entity Fields and Columns Updated: Ennov InSight

7.3

— Entity Fields and Columns Deleted: Ennov InSight

7.3

— Ennov InSight Registrations > PDS Page:

The ability to track intended ef­

fects/comorbidities for the spe­

cific Indication and

countries that are listed in the 

Indication/Intended Use Attribut­

es  page.
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• Product Details in PDS

• Associate an Intended Effect/Comorbidity

• Intended Effect/Comorbidity Attributes

Affected Area Update Benefit

IDMP Data Gen­

eration wizard
To include the changes for IDMP, Ennov InSight 7.3 intro­

duces the new IDMP Data Generation wizard. See:

— Entity Fields and Columns Added: Ennov InSight

7.3

— IDMP Data Generation

The ability to capture IDMP da­

ta in Ennov InSight in prepara­

tion for submitting IDMP data to 

EMA.

XEVMPD

Submission wiz­

ard

To include the changes based on the EMA specification for 

XEVMPD, the XEVMPD Submission wizard is updated. See: 

Entity Fields and Columns

Removed: Ennov InSight 7.3

The ability to capture

XEVMPD data in Ennov

InSight in preparation for submit­

ting XEVMPD data to EMA.

New in Ennov InSight 7.3: Publisher

This table shows new features and enhancements of publishing functionality.

The following are the new features and enhancements for Publishing functionality.

Affected Area Update Benefit

Home page:

Assembly Templates

To conform to the new eCTD 4.0 re­

quirements, the columns under As­

sembly Templates grid view are up­

dated. See:

— Entity Fields and Columns Added: 

Ennov InSight 7.3

— Ennov InSight Publishing:

eCTD 4.0 >Assembly Template At­

tributes

The ability to see additional informa­

tion for assembly templates.

Affected Area Update Benefit
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Assembly
To conform to the new eCTD 4.0 re­

quirements, the leafs, folders and 

other attributes of assembly like pub­

lishing settings library attributes, pre­

pare to publish and publishing attrib­

utes are updated. See:

— Ennov InSight Publishing: eCTD 

4.0 >Assembly Toolbar Icons> Re­

gional Information

— Ennov InSight Publishing: eCTD 

4.0 >Assembly Toolbar

Icons> Additional

Information

— Ennov InSight Publishing:

eCTD 4.0 >Assembly Attributes

— Ennov InSight Publishing: eCTD 

4.0 > Run Prepare to Publish

— Ennov InSight Publishing:

eCTD 4.0 > Submit an

Electronic Publishing Request

— Ennov InSight Publishing: eCTD 

4.0 > Publishing Leaf Elements

— Ennov InSight Publishing: eCTD 

4.0 > Assemblies > Folder Elements 

> Folder

Attributes

— Ennov InSight Publishing eCTD 

4.0 > Folder Elements > Associate 

Sender-defined Keywords to an As­

sembly Folder.

To support eCTD 4.0 and to improve 

the user experience, the assembly 

view and functionality have been up­

dated accordingly.
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— Ennov InSight Publishing: eCTD 

4.0 > Assemblies > Leaf Elements > 

Leaf Attributes

— Ennov InSight Publishing: eCTD 

4.0 > Assemblies > Leaf

Elements > Reference Leaf

Attributes

For eCTD 4.0, the Prepare to Publish 

and Publish Request

These options are unrelated to eCTD 

4.0 and are therefore

©Ennov 2024

Ennov

options do not support Paper14  pub­

lishing.

— Ennov InSight Publishing:

eCTD 4.0 > Publishing

removed.Ennov InSight RIM 7.3 Re­

lease Notes

Cumulative Ennov InSight 7.3 Re­

lease Notes

Ennov InSight RIM 7.3 Release Notes

Affected Area Update Benefit

Create Submission Wizard
The Create Submission  wizard is up­

dated with the new fields when creat­

ing a sequence. See:

— Entity Fields and Columns Added: 

Ennov InSight 7.3

— Ennov InSight Publishing eCTD 

4.0> Submissions >Amendment 

Submission> Amendment Submis­

sion

Attributes

— Ennov InSight Publishing>

Submissions >Amendment

Submission> Amendment

Submission Attributes

To maintain a new controlled vocab­

ularies for quick and easy eCTD 4.0 

specification updates in future, the 

sequence and other related submis­

sion options updates are introduced.
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Cumulative Ennov InSight 7.3 Release Notes

List of Enhancements: Ennov InSight 7.3

Affected Area Update Benefit

Folder and Leaf Attributes For files with size with the size equal 

or larger than the value set in the 

configuration, using the View File  op­

tion directs you to see the download 

status in Job Requests.

You can see the status of file down­

load under Job Requests.

If the number of folder child nodes 

exceeds the value set in the configu­

ration, the process of creating a du­

plicate folder is displayed under Job 

Requests.

You can now see the status of dupli­

cate folder creation under Job Re­

quests.

If the number of folder child nodes 

exceeds the value set in the con­

figuration, the status of assembly 

creation is displayed under Job Re­

quests.

You can now see the status of as­

sembly creation under Job Requests.

— Ennov InSight Publishing: eCTD 

4.0 > Assemblies > Leaf Elements > 

Leaf Attributes

— Ennov InSight Publishing: eCTD 

4.0 > Assemblies > Leaf

Elements > Reference Leaf

Attributes

To maintain a new controlled vocab­

ularies for quick and easy eCTD 4.0 

specification updates in future, the 

assembly and other assembly relat­

ed options updates are introduced.

For eCTD 4.0, the Modified Leaf field 

is updated to include the sequence 

number next to the leaf name.

Assembly Template For eCTD 4.0, the Import Publish­

ing Elements option is not available 

when creating the assembly tem­

plate from New > Assembly Tem­

plate or Existing Template, Assembly 

or View.

This option is unrelated to eCTD 4.0 

and therefore removed to avoid any 

confusion.
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Requested new features and enhancements are included in each release. The items are listed in descending order 

by their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are 

included in brackets [#####] following the tracking number.

Ennov InSight RIM 7.3 Release Notes

Cumulative List of Enhancements: Ennov InSight 7.3

Issue Sub-Minor Build Description

DE31047 N/A Performance issue was experienced when loading the search re­

sults for the List of Registrations with Application Properties query. 

This issue is resolved. The performance is improved.

DE30969 N/A Trying to add new values to the Event Status field in the Event Main­

tenance > Timeline/Event Plan Values DA List resulted in the Invalid 

Reference error. This issue is resolved.

DE30898,

[INC0256754]

N/A
After creating a PDS from the PDS template, the

PDS_LOCAL_CHANGE database table showed the value D for AC­

TIVE_FLAG instead of Y. This issue is resolved. Now, the value Y 

shows for ACTIVE_FLAG.

Ennov InSight : Publishing

Issue Sub-Minor Build Description

CS0589800;

[INC0108211]

6.2.0.4.0079
The US 3.3 assembly templates now support SPL and REMS and include 

additional folders and leafs: — 1.16.2.1 Final REMS:

• Final REMS (New) • Final REMS - Word (New) • SPL:

■  SPL XML (New) ■  REMS Material (New) — 1.16.2.2 Draft REMS:

• Draft REMS • Draft REMS - Word • SPL:

■  SPL XML (New)

■  REMS Material (New)
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Resolved Issues: Ennov InSight 7.3
The following issues reported to Technical Support have been resolved. Issues are listed in descending order by their 

tracking numbers. Customer incident numbers that were recorded when the issues were reported are included in 

brackets [#####] following the tracking number.

If an issue was resolved in a previously released sub- minor build, that build number is included.

Common

Issue Sub-Minor Build Description

DE30362 N/A When performing the API Post request, it was not possible to add 

more than one reference active ingredient to the active ingredient of 

the manufactured item. This issue is resolved. Now, more than one 

reference active ingredient is successfully added using API.

DE30357 N/A It was not possible to delete a product family with child entities such 

as product, component, manufactured item and the warning mes­

sage was displayed. This issue is resolved. Now, you can delete a 

product family that has child entities.

DE29488 N/A When Family Type was selected as a search criterion for the List 

of Application Countries with PDS Country and Registration Details 

query, the Invalid Reference error was displayed for the Application 

Country on the Search Results page. This issue is resolved. Now, the 

Application Country Attributes  page is displayed for the selected Ap­

plication Country .

DE29163 N/A
The About  page showed the wrong year for Ennov InSight copyright 

information. This issue is resolved.

Now, '© Calyx™ 2021.' is displayed.

DE29121 N/A In the Clinical Trial Project, on the Events  tab with an event selected, 

clicking Add Event Country failed to show an option to add an event 

country and instead the Event must be selected. message appeared. 

This issue is resolved. Now, the option to add an event country ap­

pears.

DE29048 N/A For applications, created without a product and product family, the 

Send to Concerned Parties option included both the Application and 

Product Family values on the Application Attributes > Notifications > 

Mail Settings page. This issue is resolved. Now, if there is no depen­

dency on the product or product family, this option displays the Ap­

plication value only.
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DE27756 N/A When searching for a value in the substance search selection wid­

get, two icons were not visible because the Displaying items text 

covered them. This issue is resolved by the implementation of the 

improved Substance Search  selection widget.

Publishing

Issue Sub-Minor Build Description

DE30570,

26814

N/A Using Prepare for Publishing, with the Prepare Cross Reference 

Leafs option selected, results in the error if there is a reference leaf 

to leaf published to Documentum. This issue is resolved. Now, refer­

ence list data is updated correctly after Prepare for Publishing oper­

ation and Prepare Cross Reference Leafs job displays Complete sta­

tus.

DE28798 N/A
For an Assembly Plan added to the life cycle, using the Publishing 

Settings  Edit option resulted in the Cannot get Sequence with given 

id [...] error. This

issue is resolved. Now, the Edit Publishing Settings  page is dis­

played.

DE28468 N/A After a duplicate leaf was created in a supporting assembly, the at­

tempt to delete the assembly resulted in a database error. This issue 

is resolved. Now, the supporting assembly is successfully deleted.

DE28449,

[CS0592298,

INC0115474,

PRB0043774]

N/A Opening the PDF Properties tab on a leaf from a Working assembly 

took longer than expected. took longer than expected. This issue is 

resolved. Now, the PDF Property attributes are displayed quickly.

DE27666 N/A Trying to modify or delete comments from Publishing Settings Li­

brary resulted in an error. This issue is resolved. Now, you can modi­

fy or delete comments from Publishing Settings Library.

26825 6.2.0.8 EAEU: If the Drug Registration Document Code field had a value in a 

submission, the Drug Registration Document Name was not includ­

ed in the index-r-022.xml file after publishing. The Drug Registration 

Document Name was also not saved in the leaf after an eCTD im­

port. The issue is resolved. Now, both Drug Registration Document 

Name and Drug Registration Document Code are included in the in­
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dex-r-022.xml file after publishing and in the leaf after an eCTD im­

port.

Registrations

Issue Sub-Minor Build Description

DE29159 N/A
In some 7.2.x versions of Ennov InSight , the Concentration Mea­

sure Type field was incorrectly displayed as IDMP Concentration 

Measure Type under IDMP Presentation Strength for the following 

pages:

— Component > Active Ingredient Attributes and

Reference Active Ingredient Attributes

— Pharmaceutical Product > Active Ingredient Attributes and Refer­

ence Active Ingredient Attributes

— Pharmaceutical Product > Substance Attributes and

Reference Substance Attributes

— Manufactured Item > Active Ingredient Attributes and Reference 

Active Ingredient Attributes.

— Manufactured Item > Substance Attributes and

Reference Substance Attributes

This issue is resolved. Now, the Concentration Measure Type field is 

displayed for the pages mentioned above.

DE28838 N/A The name of the Medical Product Action / Submission Status values 

was displayed incorrectly. This issue is resolved. Now, the name is 

correctly displayed as Medicinal Product Action / Submission Sta­

tus.

DE29818 N/A A pharmaceutical product could not be deleted if it was associated 

to a medicinal product. This issue is resolved. Now, a pharmaceuti­

cal product associated to a medicinal product is successfully delet­

ed.

DE29762 N/A After withdrawing an indication from a PDS, the withdrawn indica­

tion value was not available for selection in the PDS for the subse­

quent event. This issue is resolved. Now, this value is available in the 

Indication field on the Add Indication/Intended Use  page in the PDS.
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Issue Sub-Minor Build Description

26768;

[INC0058320]

6.2.0.8
The /all and /query endpoints did not work via API for the package 

set registration, product registration, full product presentation, pack­

age set - country entities and resulted in an error. This issue is re­

solved. The following endpoints work correctly via API:

— /insight/api/v2/license/packageset-registration/all

— /insight/api/v2/license/product-registration/all

— /insight/api/v2/license/full-product-presentation/all

— /insight/api/v2/license/packageset/all

— /insight/api/v2/license/packageset/country/all

Administration

Issue Sub-Minor Build Description

DE30821 N/A
When right-clicking on the Active Ingredients node in the

Product Detail Set or Product Detail Set template, the Active Ingredi­

ent > Add Active Ingredient button was displayed even if there were 

no values available for selection in the Active Ingredient field. This 

issue is resolved. Now, the Add Active Ingredient button is not avail­

able from the node.

DE30115 N/A
Saving details on the Data Administration > Applicant

Contact Values page without any value in the Applicant Contact 

Name field resulted in the Invalid Reference error message. This is­

sue is resolved. Now, the message !

Applicant Contact Name is required. appears.

DE30114 N/A The email value was not displayed as a hyperlink under Applicant 

Contact Values > Applicant Contact Email tab. and therefore was 

not possible to edit the email. This issue is resolved. Now, the value 

is hyperlinked and can be edited.

DE30062;

[INC0219608,

N/A
In the SPOR Master Lists  section, all the values for the following 

RMS lists were not displayed:
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TASK0049184] — Anatomical Therapeutic Chemical Classification System - Human.

— Medical Dictionary for Regulatory Activities.

This issue is resolved. Now, mentioned above RMS lists display val­

ues correctly.

Issue Sub-Minor Build Description

DE29064 N/A
On the Create Division Values  page, the Product Family

Maintenance section included extra Last User Updated and Last 

Changed Date fields. This issue is resolved. Now, the Create Divi­

sion Values  page does not include extra Last User Updated and Last 

Changed Date fields.

DE30042 N/A
Saving details on the Data Administration > Applicant

Contact Type Values page without any value in the

Applicant Contact Type field resulted in the Invalid

Reference error message. This issue is resolved. Now, the mes­

sage ! Applicant Contact Type is required. appears.

Ennov InSight 7.3 COB and Known Issues
For Clarification of Behavior (COB) and Known Issues, see: COB  and Known Issues  topics under Ennov InSight 7.3

Release Notes (Cumulative)

Entity Fields

Entity Fields, Columns and Options Added: Ennov InSight 7.3

The following tables describe fields and columns that were added in this release. These include the fields and 

columns that were added to support IDMP data capture and eCTD 4.0 publishing standards.

Home

Table 1: I am Looking To

Field/Column/ Option 

Name

Field 

Type

Description Business Rules

https://help.liquent.com/CalyxRIM_7.3/ReleaseNotes/GUID-92EDC4AD-E179-4993-A5CB-4D2AB651DB24.html
https://help.liquent.com/CalyxRIM_7.3/ReleaseNotes/GUID-DE18223B-0F03-40F7-A579-8418271E1313.html
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IDMP Data Genera­

tion

Tab The new IDMP Data Generation wiz­

ard is available from My Home > I am 

Looking To

The ability to capture IDMP data in En­

nov InSight in preparation for submit­

ting IDMP data to EMA.

Ennov InSight RIM 7.3 Release Notes

Cumulative

Ennov InSight 7.3 COB and Known Issues

Table 2: Assembly Templates

Field/Column/ Op­

tion Name

Field Type Description Business Rules

eCTD Standard 

Type

Read-only 

field
This column is added to

Home > Assembly

Templates grid view.

The eCTD Standard Type column contains the 

eCTD 3.2, eCTD 4.0, Paper, NeeS types based 

on the values displayed for this field on the As­

sembly Attributes  page.

Notifications

Table 3: Notifications

Field/

Column/

Option Name

Field 

Type

Description Business Rules

Sequence

Standard

Type

Option
To conform to the new eCTD 4.0 requirements, the Select 

Rule Settings and Delivery Destinations  page now includes 

the respective option when you create or modify the notifi­

cation from the:

— Notifications tab of an appropriate entity

— My Home > I am Looking To > Create new > Notifications

— Data Administration > Notifications or Data

Administration > Notification Specifications

The ability to separate 

different submission 

standards and use the 

functionality defined by 

the selected standard.

Table 4: Assembly Templates
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Field/Column/ Op­

tion Name

Field Type Description Business Rules

eCTD Standard 

Type

Read-only 

field
This column is added to

Home > Assembly

Templates grid view.

The eCTD Standard Type column contains the 

eCTD 3.2, eCTD 4.0, Paper, NeeS types based 

on the values displayed for this field on the As­

sembly Attributes  page.

Entities

Application

Table 5: Application

Field/Column/Option

Name

Field Type Description Business Rules

Sender-defined

Keywords

Codesystem

Read-only

field

To conform to the new eCTD 4.0 require­

ments, the Application Attributes  page 

now includes the respective field.

Defines code system of the 

sender-defined keywords for 

application.

Table 6: Sender-defined Keywords

Field/Column/ Op­

tion Name

Field Type Description Business Rules

Application

Name

Read-only

field

To conform to the new eCTD 4.0 requirements, the 

Sender-defined

The ability to manage 

the sender-defined

Application

Codesystem ID

Read-only

field

Keywords tab is introduced on the Application At­

tributes  page.

keywords.

Code Hyperlink

Display Name Text field

Sequence

Table 7: Sequence
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Field/

Column/

Option

Name

Field 

Type

Description Business Rules

Sequence

Standard

Type

Drop­

down

list

The Sequence 

Attributes  page 

now

— The Sequence Standard Type field contains eCTD 3.2, eCTD 4.0, Pa­

per, NeeS. If the eCTD 4.0 set for this sequence is changed to any other 

value, it results in Switch from

UUID Text field includes these 

fields.
eCTD 4.0 standard type is for sequence with existing assembly is disal­

lowed. error message.

— The system generates automatically the UUID value (version 4 of 

UUID types) on sequence creation. The UUID field is visible on the mod­

ification and view pages only. Only user with Admin permissions to 

the sequence can modify the field. The values should be unique (case-

insensitive). The entered values should pass the validation to match 

the format: a hexadecimal number in the form of xxxxxxxx-xxxxxxxx-

xxxx-xxxxxxxxxxxx, having 32 digits and 4 hyphens. If format does not 

match, the The UUID must be in the form of xxxxxxxx-xxxx-Mxxx-Nxxx-

xxxxxxxxxxxx, where x is a hexadecimal number, M is 1-5, and N is 8, 

9, a or b. message is displayed. If uniqueness is violated, the The UUID 

must be unique. message appears.

Manufactured Item

Table 8: Manufactured Item

Field/Column/Option

Name

Field Type Description Business Rules

Manufactured Item 

Quantity Operator
Drop-down

list

The Manufactured Item Attrib­

utes  page now includes this 

field.

The values for this field are available from 

the Data Administration > Other

> Concentration Measure Type

Values
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Attached Document

Table 9: Attached Document

Field/Column/ Op­

tion Name

Field Type Description Business Rules

Attachment

Document Status

Drop-down

list

The Attached Document 

Attributes  page now in­

cludes this field.

To conform to the latest IDMP specification re­

leased, the new attribute has been added to the enti­

ty.

The values for this field are available from the Data 

Administration > Other > Attached

Document Status Values

Attached

Document URL

Browse

field

The Attached Document 

Attributes  page now in­

cludes this field.

To conform to the latest IDMP specification re­

leased, the new attribute has been added to the enti­

ty.

Medicinal Product Action

Table 10: Medicinal Product Action

Field/Column/ Op­

tion Name

Field 

Type

Description Business Rules

DV Option The Medicinal Product Attributes 

page now includes this option.

To conform to the latest IDMP specification re­

leased, the new attribute has been added to the 

entity.

Field/Column/ Op­

tion Name

Field Type Description Business Rules

Family Code Hyperlink The Medical Devices node now To conform to the latest IDMP

Family Name Hyperlink includes the Function node with the corre­

sponding fields.

specification released, the new at­

tribute has been added to the

Application

Code

Hyperlink entity.

Application
Hyperlink
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Name

Product Name Hyperlink

Product Detail

Set Name

Hyperlink

Component Name Hyperlink

Function Name
Drop-down

list

Function Status
Drop-down

list

Function Status 

Date

Date

QC Status Read-only

Date QC'd Read-only

QC'd by Read-only

Function Key­

words

Text field

Function

Description

Text field

Function Com­

ments

Text field

Family Code Hyperlink The Medical Devices node now

Family Name Hyperlink includes the Manufacturer node with the 

corresponding fields

Application

Code

Hyperlink associated to the new Function node .

Application
Hyperlink
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Name

Product Name Hyperlink

Product Detail

©Ennov 2024Set 

Name

Hyperlink 27 Ennov InSight RIM 7.3 Release 

Notes Cumulative

EnnovComponent

Name

Hyperlink Entity Fields

Product Detail Set  Table 11: Medical Devices

Table 12: Package Set

Field/Column/Option

Name

Field Type Description Business Rules

— Package Item Quantity 

Operator

— Package Item - MI 

Quantity Operator

— Device Quantity Opera­

tor

Box, text 

field

The Package Set > Packaging > 

Package Detail Attributes page 

now includes this field.

The values for this field are available 

from the Data Administration > Other > 

Concentration Measure Type Values.

Pack Size Quantity Oper­

ator

Box, text 

field

The Package Set > Pack Size > 

Pack Size Detail Attributes page 

now includes this field.

Table 13: Indication/Intended Use

Field/Column/Option

Name

Field Type Description Business Rules

— Intended Effect

— Comorbidity

Multi-select The Indication/Intended 

Use node now includes the 

Intended Effect/ Comor­

Multiple sub-nodes can be 

created for the same Indi­

cation but Country values 
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— Countries bidity sub-node with the re­

spective fields.

will not be available for se­

lection.

Country values are avail­

able only when you create 

a new sub-node for another 

Indication.

If all values for the Coun­

try field are selected, it will 

not be possible to create a 

new sub-node unless you 

modify or delete the exist­

ing one.

Assembly

Table 14: Assembly Attributes

Field/Column/ Option 

Name

Field Type Description Business Rules

eCTD Standard Type Read-only field The Assembly Attributes  page 

now includes this field.

To identify the eCTD type for incorporat­

ing forward capability, this new option is 

added.

Wizards

Table 15: Create Application

Field/Option

Name

Field 

Type

Description Business Rules

Sequence

Standard

Type

Drop­

down

list

These fields are now avail­

able for the Create Applica­

tion  wizard

The field contains eCTD 3.2, eCTD 4.0, Paper, NeeS. If 

there is eCTD 4.0 set for this sequence changes to any 

other value, it results in Switch

UUID Text field when creating a sequence. from eCTD 4.0 standard type is for sequence with exist­

ing assembly is disallowed. error message.

Table 16: Create Submission
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Field/

Option

Name

Field 

Type

Description Business Rules

Sequence

Standard

Type

Drop­

down

list

These fields are now 

available in the Create 

Submission  wizard

— The Sequence Standard Type field contains eCTD 3.2, eCTD 

4.0, Paper, NeeS. If there is eCTD 4.0 set for this sequence 

changes to any other value, it results in

UUID Text field
when creating a se­

quence using following 

options:

— Initial Application

— Major Update

— Amendment

Switch from eCTD 4.0 standard type is for sequence with ex­

isting assembly is disallowed. error message.

— The system generates automatically the UUID value

(version 4 of UUID types) on sequence creation. The UUID 

field is visible on the modification and view pages only. Only 

user with Admin permissions to the sequence can modify the 

field. The values should be unique (case-insensitive). The en­

tered values should pass the validation to match the format: 

a hexadecimal number in the form of xxxxxxxx-xxxxxxxx-xxxx-

xxxxxxxxxxxx, having 32 digits and 4 hyphens. If format does 

not match, the The UUID must be in the form of xxxxxxxx-

xxxxMxxx-Nxxx-xxxxxxxxxxxx, where x is a hexadecimal num­

ber, M is 1-5, and N is

8, 9, a or b. message is displayed. If uniqueness is violated, the 

The UUID must be unique. message appears.

Table 17: Global Project Plan

Field/ Field Option Type Name

Sequence Drop-

Standard down Type list

UUID Text field

Description

These fields are now available for the Global Project Plan  wizard when creating a sequence using following project 

types:
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— Create New Events

Package Set Registration

— Сlinical  Trial

• Create New CTA and/or IND Application(s)

• Create New CTA

Application(s) and

Create New Event for

Existing IND

Application(s)

• Create New Event for

Existing CTA and/or

IND Application(s)

— Create New Events

Product Registration

— Create New Applications

Package Set Registration Business Rules

— The Sequence Standard Type field contains eCTD 3.2, eCTD 4.0, Paper, NeeS. If there is eCTD 4.0 set for this 

sequence changes to any other value, it results in Switch from eCTD

4.0 standard type is for sequence with existing assembly is disallowed. error message.

— The system generates automatically the UUID value (version 4 of UUID types) on sequence creation. The UUID field 

is visible on the modification and view pages only. Only user with Admin permissions to the sequence can modify 

the field. The values should be unique (case-insensitive). The entered values should pass the validation to match the 

format: a hexadecimal number in the form of xxxxxxxxxxxx-xxxx-xxxx-xxxxxxxxxxxx, having 32 digits and 4 hyphens. 

If format does not match, the

The UUID must be in the form of xxxxxxxx-xxxx-Mxxx-Nxxxxxxxxxxxxxxx, where x is a hexadecimal number, M is 1-5, 

and N is 8, 9, a or b. message is displayed. If uniqueness is violated, the The UUID must be unique. message appears.

Field/Option

Name

Field Type Description Business Rules
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Active

Ingredients

Selection wid­

get

This field is updated 

with improved Sub­

stance Search  selection 

widget.

Users have an ability to search for a value us­

ing a modern Selection Widget with a wider and 

more advanced search capabilities and config­

ure columns display and the number of values per 

page.

Table 18: IDMP Data Generation

Field/Option

Name

Field Type Description Business Rules

Family Type Multiselect Ennov InSight now introduces the new 

IDMP Data Generation wizard

The ability to capture IDMP data in En­

nov InSight in preparation for

Family Name Multiselect available from Wizards > IDMP Data Gen­

eration.

submitting IDMP data to EMA.

Product Name Multiselect

Application

Name

Multiselect

Action Name Text field

Status Multiselect

Display 

Columns

Multiselect

Sort Order Multiselect

Entity Fields, Columns and Options Updated: Ennov InSight 7.3

The following tables describe fields,columns and options that were modified in this release. These include the fields 

and column that were added to support IDMP data capture and eCTD 4.0 publishing standards.

Product Family

Field/Option

Name

Field Type Description Business Rules

Active
Selection wid­

get

This field is updated 

with improved Sub­

Users have an ability to search for a value us­

ing a modern Selection Widget with a wider and 
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Ingredients stance Search  selection 

widget.

more advanced search capabilities and config­

ure columns display and the number of values per 

page.

Сomparator

Product Detail Set

Table 19: Substance

Field/Option

Name

Field Type Description Business Rules

Substance

Name

Selection 

widget
This field is updated with improved Sub­

stance Search  selection widget on the Prod­

uct Detail Set Attributes > Substances Prop­

erties > Add

Substance and on the Product Detail

Set Template Attributes > Substances Prop­

erties > Add Substance pages.

Users have an ability to search for a 

value using a modern Selection Wid­

get with a wider and more advanced 

search capabilities and configure 

columns display and the number of 

values per page.

Table 20: Flu Strain

Field/Option

Name

Field Type Description Business Rules

Reference 

Strain Name

Selection 

widget
This field is updated with improved

Substance Search  selection widget on the Prod­

uct Detail Set Attributes > Active

Ingredients > Active Ingredient Detail

Attributes > Flu Strain Attributes > Add

Reference Strain and on the Product Detail

Set Template Attributes > Active

Users have an ability to search 

for a value using a modern 

Selection Widget with a wider 

and more advanced search 

capabilities and configure 

columns display and the num­

ber of values per page.
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Ingredients > Active Ingredient Detail Attribut­

es > Flu Strain Attributes > Add Reference Strain 

pages.

Component

Table 21: Reference Active Ingredient

Field/Option

Name

Field Type Description Business Rules

Reference

Active

Ingredient

Name

Selection 

widget
This field is updated with improved 

Substance Search  selection widget on 

the Component Attributes > Active

Ingredients > Reference Active Ingredi­

ent > Create Reference Active Ingredi­

ent page.

Users have an ability to search for a 

value using a modern Selection Wid­

get with a wider and more advanced 

search capabilities and configure 

columns display and the number of 

values per page.

Table 22: Manufactured Item

Field/Option

Name

Field Type Description Business Rules

Substance

Name

Selection 

widget
This field is updated with improved 

Substance Search  selection widget 

on the

Manufactured Item Attributes > Sub­

stances > Create Substance page.

Users have an ability to search for a value 

using a modern Selection Widget with a 

wider and more advanced search capabili­

ties and configure columns display and the 

number of values per page.

Table 23: Reference Substances

Field/Option

Name

Field Type Description Business Rules

Reference

Substance

Selection 

widget
This field is updated with improved Sub­

stance Search  selection widget on the

Users have an ability to search for a val­

ue using a modern Selection Widget 

with a wider and more advanced search 
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Name Manufactured Item Attributes >

Substances > Reference Substances > 

Create Reference Substance page.

capabilities and configure columns dis­

play and the number of values per page.

Pharmaceutical Product

Table 24: Substances

Field/Option

Name

Field Type Description Business Rules

Substance

Name

Selection 

widget
This field is updated with improved w 

Substance Search  selection widget on 

the Pharmaceutical Product

Attributes > Substances > Create Sub­

stance page.

Users have an ability to search for a val­

ue using a modern Selection Widget with 

a wider and more advanced search capa­

bilities and configure columns display and 

the number of values per page.

Table 25: Reference Substances

Field/Option

Name

Field Type Description Business Rules

Reference

Substance

Name

Selection 

widget
This field is updated with improved Sub­

stance Search  selection widget on the 

Pharmaceutical Product Attributes > 

Substances >

Reference Substances > Create Refer­

ence Substance page.

Users have an ability to search for a val­

ue using a modern Selection Widget 

with a wider and more advanced search 

capabilities and configure columns dis­

play and the number of values per page.

Attached Document

Table 26: Attached Document

Field/Column/ Option 

Name

Field 

Type

Description Business Rules

N/A N/A
The Attached Document  entity is now 

available for all the

To conform to the latest IDMP specifi­

cation, the entity has been updated.
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Application Procedure Types.

Table 27: Attached Document Attributes

Field/

Column/

Option Name

Field 

Type

Description Business Rules

Content Type Drop­

down list

On the Attached Document Attributes  page, 

these fields are renamed to:

To conform to the latest IDMP specifi­

cation released, the

Effective

Date

Date
— Attached Document Type

— Attached Document Effective Date

existing attributes have been updated 

for the entity.

Language Drop­

down list

— Attached Document Language

Assembly: eCTD 4.0

Table 28: Assembly Attributes

Field/Column/ 

Option Name

Field 

Type

Description Business Rules

Create an

Assembly >

Existing

Template,

Assembly or

View

Option The Create an Assembly > Existing Tem­

plate, Assembly or View option is updat­

ed on the Create Assembly  page to track 

the creation process of an assembly 

from another assembly in Job Requests 

if the number of folder child nodes ex­

ceeds the value set in the configuration.

Users can track the creation process of 

an assembly from another assembly in 

Job Requests. When creating an assem­

bly from another assembly if the num­

ber of folder child nodes exceeds the val­

ue set in a configuration, the message 

is displayed asking to check the Job Re­

quests for a status.

Table 29: Folder Attributes

Field/

Column/

Field 

Type

Description Business Rules
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Option Name

Duplicate Option The Duplicate option is updated on the 

Folder Attributes  page to track the dupli­

cate folder process in Job Requests if the 

number of folder child nodes exceeds the 

value set in the configuration.

Users can track the duplicate folder 

process in Job Requests. After clicking 

the Duplicate on the folder, if the number 

of folder child nodes exceeds the limit, 

the message is displayed asking to check 

the Job Requests for a status.

Assembly

Table 30: Document Attributes

Field/

Column/

Option

Name

Field 

Type

Description Business Rules

View File Option The View File option is updated on the Doc­

ument Attributes  page to track the download 

process in Job Requests for the files that are 

equal or bigger than the file size value set in 

the configuration.

Users can track the download process 

in Job Requests. After clicking the 

View File if the file size exceeds the 

limit, the message is displayed asking 

to check the Job Requests for a status.

Product Detail Set

Table 31: Package Set

Field/Column/ 

Option Name

Field Type Description Business Rules

Package Type
Dropdown

list

On the Package Set > Packaging > Package Detail At­

tributes page, these fields are renamed to:

To conform to the latest 

IDMP specification re­

leased, the existing

Package Item

Container

Quantity

Text field
— Package Item Type

— Package Item Quantity

— Package Item Material

attributes have been updat­

ed for the entity.
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Package

Material

Multiselect — Package Item Alternate Material — Package Item 

Component(s)

Package

Alternate

Material

Multiselect
— Package Item - MI Quantity

— Package Item - MI Quantity Unit

Package

Components

Select

Packaging MI 

Quantity

Text field

Packaging MI 

Quantity Unit
Dropdown

list

Table 32: Indication/ Intended Use

Field/

Column/

Option Name

Field 

Type

Description Business Rules

Countries Multise­

lect

This field is updated to 

optional from required 

on the Add Indication/In­

tended Use  window.

Multiple sub-nodes can be created for the same Indication 

but Country values will not be available for selection.

Country values are available only when you create a new 

sub-node for another Indication.

If all values for the Country field are selected, it will not be 

possible to create a new sub-node unless you modify or 

delete the existing one.

Wizards

Table 33: Global Project Plan
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Field/Option

Name

Field Type Description Business Rules

— Active Ingredi­

ent

— Substance

Selection 

widget
These fields are updated with improved Sub­

stance Search  selection widget for the fol­

lowing pages:

— Global Project Plan > Update

Product Detail Sets > Active

Ingredient > Input Query Filter Criteria

— Global Project Plan > Update Product De­

tail Sets > Substance >

Input Query Filter Criteria

Users have an ability to search 

for a value using a modern Selec­

tion Widget with a wider and 

more advanced search capabili­

ties and configure columns dis­

play and the number of values 

per page.

Entity Fields, Columns and Options Removed: Ennov InSight 7.3

The following table describes fields and columns that are removed with Ennov InSight 7.3.

Wizards

Table 34: XEVMPD Submission

Field/Column/Option Name Field 

Type

Description Business Rules

— Organization

— Source

— Master File Location

— ATC

— Pharmaceutical Form

— Route of Administration

— Authorised Product

Check 

box
The Select XEVPRM Sections  page

along with its corresponding fields is re­

moved from the XEVMPD

Submission  wizard. Now, after the sender 

and receiver information selection, the 

Authrorized Product Selection  page is 

available.

The ability to capture

XEVMPD data in Ennov 

InSight in preparation for 

submitting XEVMPD data 

to EMA.

Product Detail Sets

Table 35: Indication/Intended Use
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Field/Column/ 

Option Name

Field Type Description Business Rules

Intended

Effect

Multise­

lect

These fields are re­

moved from the
Multiple sub-nodes can be created for the same

Indication but Country values will not be available for

Comorbidity Multise­

lect

Add Indications/ In­

tended Use  window.
selection.

Country values are available only when you create a new sub-

node for another Indication.

If all values for the Country field are selected, it will not be 

possible to create a new sub-node unless you modify or 

delete the existing one.

UI Field

Name

Database Table Name
Database

Column Name

Databas 

e Column

Type and

Size

Description

N/A N/A
APP_ORPHAN_

DESIG_STATUS

ID

N/A ORPHAN_STATUS_TYPE is added to 

display data from Application Mainte­

nance > Orphan Statues Values DA list.

Attached Document

Table 36: Attached Document Attributes

Field/Column/ Option 

Name

Field Type Description Business Rules

Attached

Document Type

Drop-down

list

This field is removed from the 

Attached Document Attributes 

page.

The ability to capture and maintain correct 

SPOR controlled vocabulary lists in Ennov 

InSight in preparation for submitting data to 

EMA.

Database Columns and Tables
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Database Columns Added: Ennov InSight 7.3

The following Database columns were added in this release.

UI Field

Name

Database Table Name
Database

Column Name

Databas 

e Column

Type and

Size

Description

N/A N/A N/A N/A
REGULATORY_ENTITLEMENT_STA

TUS

_TYPE is updated to display data from 

Data Administration > Regulatory Enti­

tlement Status DA list

Device De­

scriptio n

MGR.PDS_MED_DEVICE 

_CHANGE

DEVICE_DESCR 

IPTION
VARCHA

R2(4000

)

To conform to the latest IDMP specifi­

cation released, the new

DEVICE_DESCRIPTION сolumn  is added 

to the

MGR.PDS_MED_DEVICE_CHANGE table.

Device De­

scriptio n of

Intended

Purpose

MGR.PDS_MED_DEVICE 

_CHANGE

DEVICE_INTEN 

DED_USE
VARCHA

R2(4000

)

To conform to the latest IDMP

specification released, the new

DEVICE_INTENDED_USE сolumn  is 

added to the

MGR.PDS_MED_DEVICE_CHANGE table.

Device De­

scriptio n 

Language

MGR.PDS_MED_DEVICE 

_CHANGE

DEVICE_LANG 

UAGE_TYPE_ID

NUMBER
To conform to the latest IDMP specifi­

cation released, the new

DEVICE_LANGUAGE_TYPE_ID

сolumn  is added to the

MGR.PDS_MED_DEVICE_CHANGE table.
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Device

Classificat 

ion

MGR.PDS_MED_DEVICE 

_CHANGE

DEVICE_CLASS 

_TYPE_ID

NUMBER
To conform to the latest IDMP

specification released, the new

DEVICE_CLASS_TYPE_ID сolumn  is 

added to the

MGR.PDS_MED_DEVICE_CHANGE table.

N/A N/A CODE
VARCHA

R2(100)

MGR.EVENT_PLAN_COUNTRY

UI Field

Name

Database Table Name
Database

Column Name

Databas 

e Column

Type and

Size

Description

Manufac­

tu red Item 

Quantity

Operator

MGR.MANUFACTURED_ 

ITEM
QUANTITY_ME

ASURE_TYPE_I

D

NUMBER
To maintain a standardized and struc­

tured method of collecting, reporting, 

coding, and evaluating authorized medi­

cinal product data, the new

QUANTITY_MEASURE_TYPE_ID is 

added to the

MGR.MANUFACTURED_ITEM table.

Package

Item

Container

Quantity

MGR.PDS_PACKSET_DE 

TAIL_CHANGE
PI_CONTAINER

_QUANTITY_M

EASURE_TYPE_

ID

NUMBER
To conform to the latest IDMP specifi­

cation released, the new

PI_CONTAINER_QUANTITY_MEAS 

URE_TYPE_ID сolumn  is added to the

MGR.PDS_MED_DEVICE_CHANGE ta­

ble.MGR.

Package

Item - MI

MGR.PDS_PACKSET_DE 

TAIL_CHANGE
MI_QUANTITY_

MEASURE_TYP

NUMBER
To conform to the latest IDMP specifi­

cation released, the new

MI_QUANTITY_MEASURE_TYPE_I



Ennov InSight 7.3 Release Notes Cumulative  | 2 - Ennov InSight 7.3 Release Notes  | 50

Quantity

Operator

E_ID D сolumn  is added to the MGR.PDS_­

PACKSET_DETAIL_CHA NGE table.

Device

Quantity

Operator

MGR.PDS_PACKSET_DE 

TAIL_CHANGE
PDS_MED_DEV

ICE_QTY_MEAS

URE_TYPE_ID

NUMBER
To conform to the latest IDMP

specification released, the new

PDS_MED_DEVICE_QTY_MEASURE

_TYPE_ID сolumn  is added to the 

MGR.PDS_PACKSET_DETAIL_CHA NGE 

table.

Pack Size

Quantity

Operator

MGR.PDS_PACKSIZE
QUANTITY_ME

ASURE_TYPE_I

D

NUMBER
To conform to the latest IDMP specifi­

cation released, the new

QUANTITY_MEASURE_TYPE_ID сolumn 
is added to the

MGR.PDS_PACKSIZE table.

UI Field

Name

Database Table Name
Database

Column Name

Databas 

e Column

Type and

Size

Description

Pack Size

Quantity

Operator

MGR.PDS_PACKSIZE_C 

HANGE
QUANTITY_ME

ASURE_TYPE_I

D

NUMBER
To conform to the latest IDMP specifi­

cation released, the new

QUANTITY_MEASURE_TYPE_ID

сolumn  is added to the

MGR.PDS_PACKSIZE_CHANGE table.

Attachme nt

Document

Status

MGR.ACTION_ATTACH 

MENT
ATTACHED_DO

CUMENT_STAT

US_TYPE_ID

NUMBER
To conform to the latest IDMP specifi­

cation released, the new

ATTACHED_DOCUMENT_STATUS_

TYPE_ID сolumn  is added to the
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MGR.ACTION_ATTACHMENT table.

Attached

Document

URL

MGR.ACTION_ATTACH 

MENT

URL
VARCHA

R2(4000

)

To conform to the latest IDMP specifi­

cation released, the new URL сolumn  is 

added to the

MGR.ACTION_ATTACHMENT table.

Sequence

Standard

Type

MGR.SEQUENCE CTD_TYPE_ID NUMBER
To conform to the new eCTD 4.0 re­

quirements, the new

CTD_TYPE_ID column is added to the 

MGR.SEQUENCE table.

UUID MGR.SEQUENCE UUID
VARCHA

R2(50)

To conform to the new eCTD 4.0 re­

quirements, the new UUID column is 

added to the

MGR.SEQUENCE table.

Senderdefined 

Keywords 

Codesyste

m

MGR.APPLICATION
CODESYSTEM_

FOR_SDKEYWO

RDS

VARCHA

R2(200)

To conform to the new eCTD 4.0 re­

quirements, the new

CODESYSTEM column is added to the 

MGR.APPLICATION table.

UUID MGR.APPLICANT_CONT 

ACT

UUID
VARCHA

R2(100)

To conform to the new eCTD 4.0 re­

quirements, the new

CODESYSTEM column is added to the 

MGR.APPLICANT_CONTACT table.

UI Field

Name

Database Table Name
Database

Column Name

Databas 

e Column

Type and

Size

Description

Prefix MGR.APPLICANT_CONT 

ACT

PREFIX
VARCHA

R2(20)

To conform to the new eCTD 4.0 re­

quirements, the new PREFIX column is 

added to the
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MGR.APPLICANT_CONTACT table.

First

Name

MGR.APPLICANT_CONT 

ACT

FIRST_NAME
VARCHA

R2(200)

To conform to the new eCTD 4.0 re­

quirements, the new PREFIX column is 

added to the

MGR.APPLICANT_CONTACT table.

Middle

Name

MGR.APPLICANT_CONT 

ACT

MIDDLE_NAME
VARCHA

R2(200)

To conform to the new eCTD 4.0 re­

quirements, the new PREFIX column is 

added to the

MGR.APPLICANT_CONTACT table.

Last Name MGR.APPLICANT_CONT 

ACT

LAST_NAME
VARCHA

R2(200)

To conform to the new eCTD 4.0 re­

quirements, the new LAST_NAME col­

umn is added to the

MGR.APPLICANT_CONTACT table.

Suffix MGR.APPLICANT_CONT 

ACT

SUFFIX Varchar 

2(20)
To conform to the new eCTD 4.0 re­

quirements, the new SUFFIX column is 

added to the

MGR.APPLICANT_CONTACT table.

Initials MGR.APPLICANT_CONT 

ACT

INITIALS Varchar 

2(20)
To conform to the new eCTD 4.0 re­

quirements, the new INITIALS column is 

added to the

MGR.APPLICANT_CONTACT table.

Delimiter MGR.APPLICANT_CONT 

ACT

DELIMITER Varchar 

2(10)
To conform to the new eCTD 4.0 re­

quirements, the new DELIMITER column 

is added to the

MGR.APPLICANT_CONTACT table.

Represent 

ed Compa­

ny

MGR.APPLICANT_CONT 

ACT

COMPANY_NA 

ME
VARCHA

R2(200)

To conform to the new eCTD 4.0 re­

quirements, the new
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Name COMPANY_NAME column is added to 

the MGR.APPLICANT_CONTACT table.

UI Field

Name

Database Table Name
Database

Column Name

Databas 

e Column

Type and

Size

Description

eCTD Stan­

dard

Type

MGR.APPLICANT_CONT AC­

T_TYPE

CTD_TYPE_ID NUMBER
To conform to the new eCTD 4.0 re­

quirements, the new

CTD_TYPE_ID column is added to the

MGR.APPLICANT_CONTACT_TYPE ta­

ble.

Associate d 

Entity ID

ODS.EXTRA_FIELDS_IP ASSOCIATED_E 

NTITY_ID

NUMBER
To conform to the new eCTD 4.0 re­

quirements, the new

ASSOCIATED_ENTITY_ID column

is added to the

ODS.EXTRA_FIELDS_IP table.

eCTD Stan­

dard

Type

ODS.ASSEMBLY CTD_TYPE_ID NUMBER
To conform to the new eCTD 4.0 re­

quirements, the new

CTD_TYPE_ID column is added to the 

ODS.ASSEMBLY table.

N/A ODS.FOLDER CV_NODE_ID NUMBER
To conform to the new eCTD 4.0 re­

quirements, the new

CV_NODE_ID column is added to the 

ODS.FOLDER table.

Priority

Number

ODS.LEAF LEAF_PRIORIT 

Y_NO

NUMBER To conform to the new eCTD 4.0 re­

quirements, the new LEAF_PRIORITY_­

NO column is added to the ODS.LEAF 

table.
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Document 

ID

ODS.LEAF LEAF_PUB_DOC 

_UUID
VARCHA

R2(100)

To conform to the new eCTD 4.0 re­

quirements, the new

LEAF_PUB_DOC_UUID column is added 

to the ODS.LEAF table.

Database Columns Changed: Ennov InSight 7.3

The following Database columns were modified in this release.

UI Field

Name

Database Table Name
Database

Column Name

Database

Column

Type and

Size

Description

N/A ODS.ECTD_IMPORT
ASSEMBLY_PRE

FIX

VARCHA

R2(30) 

has been

changed 

to

VARCHA

R2(100)

To conform to the new eCTD 4.0 re­

quirements, the

ASSEMBLY_PREFIX column size is 

changed in the ODS.ECTD_IMPORT ta­

ble.

N/A ODS.ECTD_IMPORT JOB_STATUS
VARCHA

R2(30) 

has been

changed 

to

VARCHA

R2(100)

To conform to the new eCTD 4.0 re­

quirements, the JOB_STATUS column 

size is changed in the ODS.ECTD_IM­

PORT table.
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N/A ODS.LEAF_PDF_PROPE 

RTY

FIELD_NAME
VARCHA

R2(30) 

has been

changed 

to

VARCHA

R2(100)

To conform to the new eCTD 4.0 re­

quirements, the FIELD_NAME column 

size is changed in the

ODS.LEAF_PDF_PROPERTY table.

N/A ODS.PSL_PDF_PROPER 

TY

FIELD_NAME
VARCHA

R2(30) 

has been

changed 

to

VARCHA

R2(100)

To conform to the new eCTD 4.0 re­

quirements, the FIELD_NAME column 

size is changed in the

ODS.PSL_PDF_PROPERTY table.

N/A ODS.LEAF_STATUS_TY 

PE

CODE
VARCHA

R2(30) 

has been

changed 

to

VARCHA

R2(100)

To conform to the new eCTD 4.0 re­

quirements, the CODE column size is 

changed in the

ODS.LEAF_STATUS_TYPE table.

Database Columns Removed: Ennov InSight 7.3

The following Database columns and tables were removed in this release.

UI Field

Name

Database Table Name
Database

Column Name

Database

Column

Type and

Database Table Name
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Size

Attached 

Documen

t Type

MGR.MEDICAL_DEVICE _­

UDI_TYPE
ATTACHED_DOC

UMENT_TYPE_I

D

N/A
The

ATTACHED_DOCUMENT_TYPE_

ID column is deleted form the 

MGR.MEDICAL_DEVICE_UDI_T

YPE table.

Attached 

Documen

t Type

ACTION_ATTACHMENT
ATTACHED_DOC

UMENT_TYPE_I

D

N/A
The

ATTACHED_DOCUMENT_TYPE_

ID column is deleted form the

ACTION_ATTACHMENT table.

N/A BROAD_INDC_CATEGO 

RY

N/A N/A
The BROAD_INDC_CATEGORY

table is deleted. The data has been 

migrated to the

PDS_BROAD_INDC_COUNTRY_

INTENDED_EFFECT_COMORBI

DITY table.

N/A BROAD_INDC_INTEND 

ED_EFFECT

N/A N/A
The

BROAD_INDC_INTENDED_EFF

ECT table is deleted. The data has 

been migrated to the

PDS_BROAD_INDC_COUNTRY_

INTENDED_EFFECT_COMORBI

DITY table.

N/A PRODUCT_INFORMATI 

ON_DOC_TYPE

N/A N/A
The

PRODUCT_INFORMATION_DO
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C_TYPE table is deleted.

DaaS Database Tables Changed: Ennov InSight 7.3
The following DaaS Database fields, columns or/and tables were added, modified, or removed in this release.

Field

Name

Fiel

d

Size

Database Column Name
Databas 

e Column

Size

Database Table Name

Default Flag N/A N/A N/A The APP_PRODFAM table is updated to 

display the new Default Flag field. If a 

product family is assigned to an appli­

cation this field shows YES value. Other­

wise, the value NO is shown.

N/A N/A N/A N/A
The

ATTACHED_DOCUMENT_STATUS_

TYPE table is added.

N/A N/A N/A N/A The CTD_TYPE table is added.

N/A N/A N/A N/A
The

PDS_BROAD_INDC_COUNTRY_

INTENDED_EFFECT_COMORBIDIT

Y table is added.

N/A N/A N/A N/A
The

SOURCE_OF_INFORMATION_TYPE table 

is added.

N/A N/A ATTACHED_DOCUMENT_TYPE_ID N/A The respective column is removed from 

ACTION_ATTACHMENT table.

N/A N/A
ATTACHED_DOCUMENT_STATUS_ 

TYPE_ID

N/A The respective columns are added to 

the ACTION_ATTACHMENT table.



Ennov InSight 7.3 Release Notes Cumulative  | 2 - Ennov InSight 7.3 Release Notes  | 58

URL

Field

Name

Fiel

d

Size

Database Column Name
Databas 

e Column

Size

Database Table Name

N/A N/A
COMPANY_NAME DELIMITER

FIRST_NAME

INITIALS

LAST_NAME

MIDDLE_NAME

PREFIX

SUFFIX

UUID

N/A The respective columns are added to 

the APPLICANT_CONTACT table.

N/A N/A CTD_TYPE_ID N/A The respective columns are added to 

the APPLICANT_CONTACT_TYPE table.

N/A N/A CODESYSTEM_FOR_SDKEYWORDS N/A The respective columns are added AP­

PLICATION table.

N/A N/A CODE N/A The respective column is added to the 

EVENT_PLAN_COUNTRY table.

N/A N/A QUANTITY_MEASURE_TYPE_ID N/A The respective column is added to the 

MANUFACTURED_ITEM table.

N/A N/A
DEVICE_CLASS_TYPE_ID DEVICE_­

DESCRIPTION

DEVICE_INTENDED_USE

DEVICE_LANGUAGE_TYPE_ID

N/A The respective columns are added to 

the PDS_MED_DEVICE_CHANGE table.

Field

Name

Fiel

d

Database Column Name
Databas 

e Column

Database Table Name
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Size Size

N/A N/A
MI_QUANTITY_MEASURE_TYPE_I

D

PDS_MED_DEVICE_QTY_MEASURE _­

TYPE_ID

PI_CONTAINER_QUANTITY_MEAS

URE_TYPE_ID

N/A
The respective columns are added to 

the

PDS_PACKSET_DETAIL_CHANGE table.

N/A N/A QUANTITY_MEASURE_TYPE_ID N/A The respective column is added to the 

PDS_PACKSIZE table.

N/A N/A QUANTITY_MEASURE_TYPE_ID N/A The respective column is added to the 

PDS_PACKSIZE_CHANGE table.

N/A N/A
CTD_TYPE_ID

UUID

N/A The respective columns are added to 

the SEQUENCE table.

Data Administration

Data Administration Sections Added: Ennov InSight 7.3

The following Data Administration tables, sections, options, widgets, filters or fields were added for Ennov InSight 7.3.

Data Administration: Application Maintenance

Table 37: Regulatory Entitlement Status Values

Entity Affected Field Name Value List Description

N/A
— Regulatory Enti­

tlement

Status Name

— Term ID

— Term Name

— Description

— Last User

To conform to IDMP requirements, the Regulatory Entitle­

ment Status Values table with the

corresponding fields and RMS tab is introduced in Data 

Administration. This list is mapped to the SPOR Master 

Lists > Regulatory Entitlement Status.
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Updated

— Last Changed

Date

— Active Flag

— RMS Term ID

— RMS Modified

On

— RMS Status

Data Administration Section: Medical Device Maintenance

Table 38: Device Classification Values

Entity Affected Field Name Value List Description

N/A
— Device

Classification

Name

— Countries

— Term ID

— Term Name

— Description

— Last User

Updated

— Last Changed

Date

— Active Flag

To conform to IDMP requirements, the Device

Classification Values table with the corresponding fields 

is introduced in Data Administration.

Data Administration Section: eCTD 4.0 Submission Maintenance

Table 39: CV Profile Values
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Entity Affected Field Name Value List Description

Publishing Settings Library
— CV Profile

Name

— Region

— Version

— Category

— Specification 

Name

— Specification

OID

— Last User

Updated

— Last Changed

Date

— Active Flag

To enable new controlled vocabularies to easily work 

with future eCTD 4.0 specification updates, the CV Pro­

file Values  table is introduced.

Table 40: CV Details

Entity Affected Field Name Value List Description

Publishing Settings Library
— Name

— Version

— OID

— Can be

associated?

— Can be

disassociated?

To show the set of controlled vocabularies currently as­

sociated with selected eCTD 4.0 CV profile, the CV De­

tails table is introduced.

Table 41: Sender-defined Keyword Values
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Entity Affected Field Name Value List Description

Publishing Settings Library
— Code

— Display Name

— Last User

Updated

— Last Changed

Date

— Active Flag

To maintain a new controlled vocabularies improvement 

for quick and easy eCTD 4.0 specification updates in fu­

ture, the Senderdefined Keyword Values  table is intro­

duced.

Data Administration Section: Other

Table 42: Attached Document Status Values

Entity Affected Field Name Value List Description

Attached Document
— Attached

Document

Status Name

— Last User

Updated

— Last Changed

Date

— Active Flag

To conform to IDMP requirements, the Attached

Document Status Values table with the corresponding 

fields is introduced in Data Administration.

Table 43: Source of Information Values

Entity Affected Field Name Value List Description

N/A
— Source of Informa­

tion

Name

— Term ID

To conform to IDMP requirements, the Source of Infor­

mation Values table with the corresponding fields and 

RMS tab is introduced in Data



Ennov InSight 7.3 Release Notes Cumulative  | 2 - Ennov InSight 7.3 Release Notes  | 63

— Term Name

— Description

— Last User

Updated

— Last Changed

Date

— Active

— RMS Term ID

— RMS Modified

On

— RMS Status

Administration. This list is mapped to the SPOR Master 

Lists > Source of Information.

Data Administration Section: SPOR Master Lists

Entity Affected Field Name Value List Description

N/A
— List Id

— List Name

— List Owner

— Term Id

— Term Name

— Short Name

— Status

— Domain

— Modified On

— Mapping

Source

— Source Term

Id

To conform to IDMP requirements to capture additional 

RMS data, the following tables are introduced:

— Container Category

— eCTD EU Context of Use

— Medical Device Classification

— Medical Device Legislative Category

— Medicinal Product Type

— Medicine Profile

— Regulating Authority Submission Unit Type

— Source of Information
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— XEVMPD Code

— Description

— Comments

— Version

Number

— ISO Code

Data Administration Section: Submission Maintenance  Table 44: Applicant Contact Type Values

Entity Affected
Field/Column

Name

Value List Description

Applicant Contact Type eCTD Standard Type To conform to the new eCTD 4.0 requirements, the Ap­

plicant Contact Type Values  table now includes the this 

column.

Applicant Contact Type
— Region

— CV OID

— Code

— Value

To make the applicant contact type updates compati­

ble with eCTD 4.0, the applicant contact type values now 

can be added using the Associate eCTD 4.0 Applicant 

Contact Type option taking values directly from the cor­

responding controlled vocabulary.

Data Administration Sections Updated: Ennov InSight 7.3

Data Administration tables, sections, options, widgets, filters or fields updated in Ennov InSight 7.3 release.

Data Administration Section: Other

Table 45: Attached Document Content Type Values

Entity Affected Column/Field Name Value List Description

Attached

Document

Content Type

Values

— Term ID

— Term Name

— Short Name

— Mapping Source

To capture and maintain correct SPOR controlled vocabulary lists for 

submitting data to EMA, the Attached Document Content Type Values 

is updated to allow RMS data association only from following SPOR 

Master Lists:

— Product Information Document Type
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— Source Term ID

— xEVMPD Code

— ISO Code

— eCTD EU Context of Use

— Regulating Authority Submission Unit Type

Table 46: Certificate Master File Values

Entity Affected Column/Field Name Value List Description

Substance Substance Reference This field is updated with improved Substance Search  selec­

tion widget.

Data Administration Section: Product Detail Set Maintenance

Table 47: Component Type Values

Entity Affected Column/Field Name Value List Description

N/A
— RMS Term ID

— RMS Modified On

— RMS Status

To conform to IDMP requirements to capture additional RMS 

data, the Сomponent  Type Values grid now includes the re­

spective columns. The RMS tab is updated to allow data as­

sociation from SPOR Master Lists > Container Category .

Entity Affected Column/Field Name Value List Description

Substance Substance Name
This field is updated with improved Substance

Search  selection widget on the Manufacturer > Global Prod­

uct Details > Global Detail Sets page (Detail Type > Sub­

stance).

Table 48: Device -Type of Combination Values

Entity Affected Column/Field Name Value List Description

N/A
— RMS Term ID

— RMS Modified On

— RMS Status

To conform to IDMP requirements to capture additional RMS 

data, the Device -Type of

Combination Values grid now includes the respective 

columns. The RMS  tab on the Device -Type of Combination 

Values  page is enabled and updated to allow data associ­

ation from SPOR Master Lists > Medical Device Legislative 

Category.
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Table 49: Intended Effect Values

Entity Affected Column/Field Name Value List Description

N/A
— Term ID

— Term Name

— Description

— Last User

Updated

— Last Changed

Date

— Active Flag

— RMS Term ID

— RMS Modified On

— RMS Status

The Intended Effect Values attributes page is updated with 

RMS tab, including the columns to associate and display the 

data from SPOR Master Lists > Medicine Profile .

Table 50: Manufacturer Values

Table 51: Substance Type Values

Entity Affected Column/Field Name Value List Description

Substance
— Term ID

— Term Name

— Description

— Last User

Updated

— Last Changed

Date

— Active

— RMS Term ID

The Substance Type Values page is updated with RMS tab, 

including the columns to associate and display the data 

from SPOR Master Lists > Ingredient Role.
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— RMS Modified On

— RMS Status

Data Administration Section: Registration Maintenance

Table 52: Data Carrier Type Values

Entity Affected Column/Field Name Value List Description

N/A
— Term ID

— Term Name

— Description

— Last User

Updated

— Last Changed

Date

— Active Flag

— RMS Term ID

— RMS Modified On

— RMS Status

To conform to IDMP requirements to capture additional RMS 

data, the Data Carrier Type Values  attributes page is updat­

ed with RMS tab, including the columns to associate and dis­

play the data from SPOR Master Lists > Source of Informa­

tion.

Table 53: Registration Status Values

Entity Affected Column/Field Name Value List Description

Registration Status 

Values
— Term ID

— Term Name

— Description

— Last User Updated

— Last Changed Date

— Active Flag

— RMS Term ID

To conform to IDMP requirements to capture additional RMS da­

ta, the Registration Status Values  attributes page is updated to 

associate and display the data from SPOR Master List > Regula­

tory Entitlement Status.
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— RMS Modified On

— RMS Status

Data Administration Section: Submission Maintenance

Table 54: Applicant Contact Values

Entity Affected
Field/Column

Name

Value List Description

Applicant Contact
— UUID

— Prefix

— First Name

— Middle Name

— Last Name

— Suffix

— Initials

— Delimiter

— Represented

Company

Name

To support 4.0 and 3.2 specification updates, you can 

now create an applicant contact with specific attributes. 

The Applicant Contact Values  table is now updated with 

these fields.

Data Administration Sections Removed:Ennov InSight 7.3

The following Data Administration tables, sections, options, widgets, filters or fields were removed in Ennov InSight 

7.3.

Data Administration Section: Application Maintenance

Table 55: Product Information Document Type Values

Entity

Affected

Column/Field Name Description
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N/A
— RMS Term ID

— RMS Modified On

— RMS Status

— Last User Updated

— Last Changed Date

— Active Flag

— Product Information Document Type Name

The Product Information Document Type Val­

ues  entity along with its fields and columns 

are removed from the

Application Maintenance  section.

Data Administration Section: Product Detail Set Maintenance

Table 56: Substance Roles Values

Entity Affected Column/Field Name Description

Substance
— RMS Term ID

— RMS Modified On

— RMS Status

The RMS  tab along with its fields and columns are removed from this 

table.

Data Administration Section: Registration Maintenance

Table 57: Qualified Person Responsible for Pharmacovigilance (QPPV) Values

Entity Affected Column/Field Name Description

N/A
— RMS Term ID

— RMS Modified On

— RMS Status

The RMS  tab along with its fields and columns are removed from this 

table.

Security Administration

Security Administration Tables Updated: Ennov InSight 7.3

Security Administration tables, sections, or fields updated in Ennov InSight 7.3 release.

Security Administration Section: License Modules
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Entity Affected Column/Field Name Description

N/A IDMP and xEVMPD To support user's business flow of usage xEVMPD and IDMP, 

this field is now split into two fields: IDMP and xEVMPD.

Query Fields

Query Fields and Columns Updated: Ennov InSight 7.3

The following table describes fields that were updated with Ennov InSight 7.3

Registration Planning and Tracking Queries

Field/Column

Name

Field Type Description

Active

Ingredient

Selection widget
This field is updated with improved Substance Search  selection widget on 

the following pages:

— List of Product Families

— Applications Sent, Submitted, or Approved - Searched by INN or Active 

Ingredient  when Use Active Ingredient Name Filter is selected for INN or Ac­

tive Ingredient

Product Detail Management Queries

Field/Column

Name

Field Type Description

Active Ingredient

Name

Selection widget
This field is updated with improved Substance Search  selection widget 

on the following pages:

— List of Active Ingredient Manufacturers

— List of Active Ingredient Function Manufacturers

— List of Active Ingredient Material Manufacturers

— List of Registrations with Active Ingredients

Ennov InSight RIM 7.3 Release Notes
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Cumulative Security Administration

Field/Column Name Field Type Description

Substance Name Selection widget
This field is updated with improved Substance Search  selection widget 

on the following pages:

— List of Excipient Manufacturers

— List of Registrations with Excipients

Field/Column Name Field Type Description

Substance Name Selection widget This field is updated with improved Substance Search  selection widget 

on the List of Products with Registration and Flu Strain Details  page.

Job Requests

Job Requests Updated: Ennov InSight 7.3

The following table describes the columns that were updated with Ennov InSight 7.3.

Job Requests

Column 

Name

Column Type Description

Job Name Text
To support eCTD 4.0, the column in Job Requests > Search Results now includes the 

following values when an assembly is added, removed individually or, removed in 

bulk from life cycle:

— Add Assembly to Lifecycle

— Remove Assembly from Lifecycle

— Duplicate Folder

— Creating assembly

Job Name Text eCTD 4.0: When a leaf is auto-created on assigning a document, the status of the Pri­

ority number recalculation is shown under Job Requests > Search Results.

Job Name Text
To notify users when the long running process is complete for the assembly files and 

folders with the size equal or bigger than the file or folder child nodes value set in the 

configuration, the column in Job
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Requests > Search Results now includes the Download document value.

Job Name Text
With the IDMP Data Generation wizard implementation, the IDMP Data

Generation Initial Flow value is added to Job Requests > Search Results.

Cumulative Job Requests



Chapter 3. Ennov InSight 7.3.1 Release Notes

Ennov InSight 7.3.1 Release Notes
The Release Notes contain information about updated files, new functionality, resolved issues, and any open issues 

or workarounds in this release of Ennov InSight 7.3.1.

The details in these Release Notes supersede all similar details that appear anywhere else in this release of the 

product or its other documentation. In-Process Linking Updates

To support in-process linking for Linking plug-in (PDF) without accessing the Document Management System (DMS) 

of users, the following sections are updated:

— Publishing Settings Library

— Document Attributes

See: Entity Fields, Columns and Options Removed: Ennov InSight 7.3.1. Linking plug-in (PDF)/Linking add-in (Word) 

Issue Resolved

In Ennov InSight 7.3.1, the authoring links created using Linking plug-in (PDF)/ Linking add-in (Word) with target 

documents in all supported file shares work correctly. See: Defect DE30391 in Ennov InSight 7.3.1, Resolved Issues

XEVMPD Updates

To support the latest European Medicine Agency (EMA) XEVMPD requirements, the following entities and wizards 

have been updated. See: Entity Fields and Columns Added: Ennov InSight 7.3.1, Database Columns Changed Ennov 

InSight 7.3.1  — Entities:

• Registration Attachment

— Wizards:

• XEVMPD Submission wizard

XEVMPD Submission Updates

In Ennov InSight 7.3.1, access rules for the XEVMPD Submission wizard are changed. Now, users with Data 

Administration rights set to NO can also create the XEVPRM .zip file for submission to the EMA.

Entity and Tab Changes

To improve application usability, changes have been made to the following entities and tabs. See: Entity Fields and 

Columns Added: Ennov InSight 7.3.1.

— Entities:
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• Create Pending Changes

— Tabs:

• Pending Changes

Privacy Policy

To ensure compliance with data protection requirements, a link to the Privacy Policy  is added to the Ennov InSight 

application, available from the Username menu on the top-right corner.

Regulatory Updates

Support for South Africa (ZA) eCTD Module 1 version 3.0.

For more information about new ZA values, extensions and rules, see:

— Ennov InSight 7.3 Publisher > Submissions > Create eCTD Wizard > eCTD Attributes South Africa

— Ennov InSight 7.3 Publisher > Extension Type and Usage > Extension Type: Regional Folders > South Africa

Affected Area Update Benefit

Pending Changes The Pending Changes tab is updated with new op­

tion. See Entity Fields, Columns and Options Added: 

Ennov InSight 7.3.1  and Registrations > Apply Pend­

ing Changes.

The ability to apply all/selected pending 

changes without closing an event.

Pending Changes The Pending Changes tab is updated with new 

column. See Entity Fields, Columns and Options 

Added: Ennov InSight 7.3.1  and Registrations > 

Pending Changes and Entity Attributes.

The ability to view countries associated 

with Change Scope > Registration on the 

Pending Changes tab.

— Ennov InSight 7.3 Publisher > Administrative Activity > Import eCTD Applications > Prepare for Bulk eCTD Import > 

ZA 3.0 Applications

— Ennov InSight 7.3 Administration > eCTD Codes > eCTD Filing Types for ZA

— Ennov InSight 7.3 Administration > eCTD Filing Types for ZA > eCTD Sub-Filing Types for ZA

— Ennov InSight 7.3 Administration > Assembly XML Specification > m1-za v. 3.0

TOC Templates Updates

The following TOC templates have been added for Chinese and Japanese languages: — 

CNSampleTOCTemplate.docx

— JPSampleTOCTemplate.docx

https://www.calyx.ai/privacy-policy/
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Oracle Updates

To reduce the risk of the cursor leaks issue that was found to be an Oracle issue, Oracle jdbc driver is updated.

New in Ennov InSight 7.3.1: Registrations

New features and enhancements for Registration functionality is listed below.

Affected Area Update Benefit

Create Pending 

Changes

The Create Pending Changes  wizard is updated 

with new Full Product Presentation  flow. See Entity 

Fields, Columns and Options Added: Ennov InSight 

7.3.1, Registrations > Pending Changes and Entity 

Attributes.

The ability to enter pending changes val­

ues for Full Product Presentation  on the 

Pending Changes tab.

Create Pending 

Changes

The Create Pending Changes wizard is updated with 

new fields for Registration  flow. See Entity Fields, 

Columns and Options Added: Ennov InSight 7.3.1.

The ability to enter more values for Reg­

istration  flow on the Pending Changes 

tab.

Create Pending 

Changes
The Change Scope > Registration Package

Set flow is updated. See Entity Fields, Columns and 

Options Removed: Ennov InSight 7.3.1.

The ability to create pending changes 

quicker as there is no need now to popu­

late extra field.

Create Pending 

Changes
The Change Scope > Registration Package

Set Country flow is updated. See Entity Fields, 

Columns and Options Removed: Ennov InSight 

7.3.1.

The ability to create pending changes 

quicker as there is no need now to popu­

late extra fields.

Registration At­

tachment
The Registration Attachment  page is updated with 

new field. See Entity Fields, Columns and

Options Added: Ennov InSight 7.3.1 and Registra­

tions > Registration Attachment > Registration At­

tachment Attributes.

The ability to create XEVMPD submis­

sions in accordance with the latest Eu­

ropean Medicine Agency (EMA) require­

ments.

Full Product Pre­

sentation
The Full Product Presentation > Registrations FPP 

Attachments > Attached Name is updated with new 

field. See Entity Fields, Columns and Options Added: 

Ennov InSight

The ability to create XEVMPD submis­

sions in accordance with the latest Eu­

ropean Medicine Agency (EMA) require­

ments.
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7.3.1 and Registrations > Registration Attachment > 

Registration Attachment Attributes.

XEVMPD

Submission wiz­

ard

The generated XEVMPD file is updated with new val­

ue. Also, access rules for the XEVMPD Submission 

wizard are changed. See Entity

Fields, Columns and Options Added: Ennov

InSight 7.3.1 and XEVMPD > Authorised

Product Attachments

The ability to create XEVMPD submis­

sions in accordance with the latest Eu­

ropean Medicine Agency (EMA) require­

ments. The ability to use the XEVMPD 

Submission  wizard for users without ac­

cess rights configured in the Security 

Administration.

Resolved Issues: Ennov InSight 7.3.1
The following issues reported to Technical Support have been resolved. Issues are listed in descending order by their 

tracking numbers. Customer incident numbers that were recorded when the issues were reported are included in 

brackets [#####] following the tracking number.

If an issue was resolved in a previously released sub- minor build, that build number is included.

Common

Issue
SubMinor

Build

Description

DE31646,

[INC0315574]

N/A
Trying to create or update the Change External Number value using 

the API /change/create-or-update endpoint resulted in the following 

error message: Change

External Number must be unique in the system.

This issue is resolved. Now, External Change Number is successfully 

created/updated via the API /change/ create-or-update endpoint.

DE31589 N/A Veeva Single sign-on (SSO) authorization from DMS Browse failed to 

work and it was not possible to use the Veeva Vault content. This is­

sue is resolved. Now, the Veeva Single signon (SSO) works correctly.

DE31469,

[INC0303021]

N/A When using the Global Project Plan  wizard, if multiple products were 

associated with a product family, it took longer time than expected 

to download applications on the Select Application  page. This issue 

is resolved. Now, it takes less time to download the applications.
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DE31436 N/A The Pending Changes tab was displayed on the Events Attributes 

page even when Product Registration was selected for the Registra­

tion Type field. This issue is resolved. Now, the Pending Changes tab 

is not displayed when Product Registration is selected.

DE31074,

[TASK0053554]

N/A Trying to update a specific submission with applied overrides took 

longer time than expected. This issue is resolved. Now, the perfor­

mance is improved.

DE31030,

[INC0276375]

N/A After a sequence was created for the EU CTR application and asso­

ciated with workflow, trying to navigate to the Activity page or the 

Workflow page resulted in the Invalid reference error message. This 

issue is resolved. Now, both pages are displayed correctly.

Issue
SubMinor

Build

Description

DE31029,

[INC0273676]

N/A
If an indication associated with product family was deactivated, try­

ing to add it to an orphan designation using the following endpoints 

resulted in an error:

— API /orphan-designation/update

— API /orphan-designation/create

— API /orphan-designation/create-or-update

This issue is resolved. Now, a deactivated indication associated with 

a product family is successfully added to an orphan designation via 

API.

DE31016,

[TASK0051801,INC0273635]

N/A
It was possible to create an orphan designation using the

API /orphan-designation/create endpoint even if an application did 

not fulfill the following criteria:

— Marketing Authorisation Application (MAA) application type is se­

lected.

— EMA country is selected.

— Orphan Drug flag is set to Yes.
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This issue is resolved. Now, it is not possible to create an orphan 

designation for an application that does not match the mentioned 

criteria using API.

DE31013,

[INC0276375]

N/A
In 7.2.5, 7.2.7, 7.2.8 and 7.3 versions of Ennov InSight , an option 

used for internal testing was exposed. The

Terminology System List option was displayed under Data Adminis­

tration > SPOR Master Lists. This issue is resolved with the removal 

of the Terminology System List option.

DE30866,

[TASK0050835]

N/A
If the Veeva session was expired when using the Veeva

Single sign-on (SSO) profile with a name that matched the Ennov 

InSight profile name, re-authorization was required to download a 

file assigned from Veeva DMS using the File View option. This issue 

is resolved. Now, if the Veeva session is expired when using the Vee­

va SSO profile with a name that matches the Ennov InSight profile 

name, Veeva reauthorization is not required to download the file us­

ing File Menu.

Issue
SubMinor

Build

Description

DE29199 N/A When there were 1000+ product families, trying to associate a prod­

uct to an application ended in the Invalid reference error. This issue 

is resolved. Now, product is associated successfully.

DE28570 N/A
After changing the repository details in Technical

Administration, the session of the previous user was still used and 

this caused issues with DMS login. As a result, performing any task 

in DMS required a server restart to complete. This issue is resolved. 

Now, performing a task in DMS does not require a server restart.

DE28565 N/A The UCSampleTOCTemplate.docx template caused issues with 

fonts. This issue is resolved. Now, the two new TOC templates used 

for Chinese and Japanese text are created without fonts that caused 

the font issue.

DE26800, 26725,
N/A Ennov InSight sometimes failed to connect with the Veeva vault se­

lected and instead established a connection with another Veeva 
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[INC0052690] vault if a user had more than one configured in the same domain. 

This issue is resolved. Now, Ennov InSight always establishes a con­

nection with the selected vault.

Publisher

Issue Sub-Minor Build Description

DE31352,

[TASK0361714]

N/A For a submission with files of 1 GB size or more, performing the Re­

calculate Checksums operation failed and Job Requests > Job Mes­

sage displayed the Query stopped responding message. This issue 

is resolved. Now, for large submissions, the Recalculate Checksums 

operation completes as expected.

DE31334,

[TASK0444686]

N/A When Recalculate Checksums was performed on an assembly with 

1000+ leafs, the Job Requests > Job Message query displayed the 

Error: could not execute query message. This issue is resolved. Now, 

the Recalculate Checksums operation completes correctly and the 

Job Message displays relevant information.

Issue Sub-Minor Build Description

DE31322 N/A Rendering of selected files sometimes failed if a folder contained 

many files (approximately 80,000 or more). This issue is resolved. 

Now, for a file in the folder with many files, rendering completes suc­

cessfully.

DE31296,

[TASK0373863]

N/A When working with large assemblies, performing the Recalculate 

Checksums operation even on a single element timed out and failed. 

This issue is resolved. Now, the performance is improved, and the 

Recalculate Checksums operation is performed only on the files se­

lected by the user.

DE31146 N/A
When searching a document using the values of DMS

Repository, Repository, Document Type, and Search Folders as 

search criteria, the DMS Search Results failed to show the keywords 

and other repeated or custom attributes. This issue existed only 

for Documentum. This issue is resolved. Now, the DMS Search Re­

sults are displayed with values if they are added to the document 

searched
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DE31122 N/A
If file downloading was interrupted due to any technical issues, try­

ing to download the same file later resulted in the Invalid reference 

error. This issue is resolved.

Now, the file is downloaded successfully.

DE31057 N/A The DMS search on a folder that contained around 1000 or more 

documents took longer than expected. This issue is resolved. The 

performance is improved.

DE30878 N/A
Performance issue was experienced when creating a working as­

sembly in an application with 1000 sequences added to the life cy­

cle and multiple nodes in the

Submitted view. This issue is resolved. Now, performance is im­

proved

DE30601 N/A
When creating a TOC in an assembly using the

UCSampleTOCTemplate.docx template, the Generate TOC jobs 

failed. This issue is resolved. Now, the template is updated and Gen­

erate TOC jobs complete successfully.

Issue Sub-Minor Build Description

DE30593 N/A Trying to create an assembly from an XML file with specific meta­

data populated for US Module1 v3.3 resulted in the following error 

message: You do not have the appropriate privileges to access the 

requested resource error message. This issue is resolved. Now, an 

assembly is successfully created from an XML when using the US 

Module v3.3 specification.

DE30518 N/A The Application Number value in the US Admin Forms folder was 

missing when the US 3.3 assembly had been created using the Cre­

ate eCTD  wizard causing the publish operation to fail. This issue is 

resolved. Now, the wizard populates the Application Number field 

automatically by selecting a single value from the Application Con­

tain Files? entry, if it is set to Yes. As a result, publishing completes 

successfully even if the Application Number has not been populated 

directly by a user.

DE30391 N/A
Authoring links created using Linking plug-in (PDF) or
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Linking add-in (Word) did not work with the enhanced Secured File 

System of Ennov InSight when a document was assigned and Run 

Link Inspector was performed. This issue is resolved. Now, the links 

work with the enhanced Secured File System of Ennov InSight .

DE29594 N/A When a sequence with sequence code starting with the upper case 

P was created and the assembly was published, using Recalculating 

Checksum generates extra files in the output location. This issue is 

resolved. Now, Recalculating Checksum operation completes cor­

rectly and does not generate extra files.

Registrations

Issue Sub-Minor Build Description

DE30067,

[INC0221620

PRB0044941]

N/A
Even after an event was closed as Approved, the Medical Device val­

ue with Withdrawn status was displayed in the

Medical Device Reference field on the PDS Detail > Package Set > 

Add Package page. When a new event was assigned to the same 

PDS, the Medical Device value with Withdrawn status was also dis­

played in the Medical Device Reference field. Both issues are re­

solved. Now, if an event is closed as Approved or a new event is as­

signed to the same PDS Detail, the withdrawn Medical Device value 

is not displayed in the Medical Device Reference field.

Ennov InSight 7.3 COB and Known Issues
For Clarification of Behavior (COB) and Known Issues, see: COB  and Known Issues  topics under Ennov InSight 7.3 

Release Notes (Cumulative)

Entity Fields

Entity Fields, Columns and Options Added: Ennov InSight 7.3.1

The following tables describe fields, columns and options that were modified in this release.

Events

Ennov InSight RIM 7.3 Release Notes

Cumulative

Ennov InSight 7.3 COB and Known Issues

https://help-insight.ennov.com/CalyxRIM_7.3/ReleaseNotes/clarification_of_behavior_ennov_insight_7_3.html
https://help-insight.ennov.com/CalyxRIM_7.3/ReleaseNotes/known_issues.html
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Table 58: Pending Changes

Field/

Column/

Option

Name

Field 

Type

Description Business Rules

Apply

Pending

Changes

N/A The Apply Pending Changes 

icon is added to the Pend­

ing Changes tab on the 

Events Attributes  page.

If no pending changes are selected, using the Apply Pending 

Changes option results in the following alert message dis­

played: At least one value must be selected.

If one or more pending changes are selected, using the Ap­

ply Pending Changes option results in the following message 

displayed: You are about to apply pending changes. Click OK 

to continue.

Applied pending changes are not displayed on the Pending 

Changes tab.

If two pending changes are created for the same entity, the 

Pending Changes tab shows only one, the newest, value.

Country N/A The Pending Changes tab 

now includes the respective 

column.

Improves the usability of the application

Table 59: Create Pending Changes

Field/Column/ Op­

tion Name

Field Type Description Business Rules

Application

Reviewing

Countries

Multise­

lect

The Full Product Presen­

tation  flow is added to 

the Create

After Full Product Presentation  flow is selected, the Ap­

plication Reviewing Countries field is displayed. Once it 

populated, the Registrations

Registrations Multise­

lect
Pending Changes >

Select Pending

Changes Entities >

field appears. The Full Product Presentation appears 

after registrations values are selected.
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Full Product Pre­

sentation

Multise­

lect

Change Scope and in­

cludes all the

All other fields are displayed on the Enter values for 

Pending Changes  page available after

Full Product

Name

Text field respective fields. clicking on the Next button on the Select Pending 

Changes Entities page. If no values are selected for the 

fields Application Reviewing

Full Product Short 

Name

Text field
Countries, Registrations or Full Product

Presentation, it is impossible to create pending

Product INN/ Com­

mon Name

Text field
changes.

It is impossible to apply changes to FPP using

Product

Company Name

Text field the Pending Changes tab if the following fields are pop­

ulated with the same values as the other

Product Strength Text field
FPPs applied to the same registration:

Concatenation of Full Product Name, EEA

Country, Language, Package Description,

Product Form Text field Authorisation Status, Authorisation/Renewal

Authorisation Sta­

tus

Select Date, EVCode.

Authorized

Pharmaceutical

Form

Selection 

widget

Authorisation/ Re­

newal Date

Date

Withdrawn/

Invalidated Date

Date

Information Date Date
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XEVMPD Com­

ments

Text field

Table 60: Create Pending Changes

Field/Column/ Op­

tion Name

Field Type Description Business Rules

License Issue 

Date

Date
The Registration  flow on the

Create Pending Changes > Select

New fields are displayed on the Enter val­

ues for Pending Changes  page

Expiration Date/

Registration

Valid Until

Date Pending Changes Entities page now 

includes the respective fields.

available after clicking on the Next button 

on the Select Pending Changes Entities 

page.

Registered ATC Multiselect

Registration Attachment

Table 61: Create Registration Attachment

Field/Column/Option

Name

Field Type Description Business Rules

2nd Attachment

Language

Drop-down The Create Registration 

Attachment  page now in­

cludes the respective field.

The new 2nd

Attachment Language field 

is displayed under the At­

tachment Language field. 

Values for the field are tak­

en from the Other > Lan­

guage Values DA

List.

The 2nd Attachment

Language field can be up­

dated on the pages Modify 

Registration
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Attachment  and Copy

Registration

Attachment.

Full Product Presentations

Table 62: Registration FPP Attachment

Field/Column/ 

Option Name

Field 

Type

Description Business Rules

2nd

Attachment

Language

Select
On the Create Registration FPP Attach­

ment  page, the concatenation of fields 

that displays in the Attached Name field 

now includes the respective field. The 

concatenation of fields displays in the 

following order: Internal Name - Attach­

ment

Language - 2nd Attachment Language - 

Attachment Name Attachment Version.

Values for the 2nd Attachment

Language field are taken from the Other > 

Language Values Data Administration List.

The 2nd Attachment Language field can 

be populated only on the Create Registra­

tion FPP Attachment  page. For the following 

pages, this field is readonly:

— Registration FPP Attachment

Attributes

— Copy Registration FPP Attachment

— Modify Registration FPP Attachment

Wizards

Table 63: XEVMPD Submission

Field/Column/ Op­

tion Name

Field 

Type

Description Business Rules

2nd Attachment

Language

N/A XEVMPD XML file gener­

ated after using XEVM­

PD Submission  wiz­

ard now displays the re­

spective value.

The 2nd Attachment Language value is displayed in the 

<attachment> section of the XEVMPD XML file under 

<languagecode2> tag.

If 2nd Attachment Language field is not populated for 

the Registration Attachment  entity, <languagecode2> tag 

also remains blank.
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Entity Fields, Columns and Options Removed: Ennov InSight 7.3.1

The following table describes fields, columns and options that were removed in this release.

Assembly, Assembly Templates

Table 64: Publishing Settings Library

Field/Column/ 

Option Name

Field Type Description Business Rules

In-Process

Rendition

Location

Browse

field

This field is removed from

Publishing Settings Library > Edit

Publishing Settings for Assembly

Specific Publishing Settings Library 

(APL) and Publishing

Settings Library Template (PLT).

To support the default in-process link­

ing for Linking plug-in (PDF) without the 

need to access the DMS, the configura­

tion privilege for the user is removed.

Table 65: Document

Field/Column/ Option 

Name

Field Type Description Business Rules

Prepare

Documents for

Linking Location

Read-only

field

This field will no longer be avail­

able on the Document Attributes 

page for the Prepare Document 

for Linking option applied.

To support the default in-process link­

ing for Linking plug-in (PDF) without the 

need to access the DMS, the Prepare Doc­

uments for Linking Location field is re­

moved.

Events

Field/

Column/

Option Name

Field Type Description Business Rules

Medicinal Prod­

ucts

Multiselect
This field is removed from the

The Registration Package Sets field is still avail­

able to populate. It appears after values for the 

fields Application Reviewing Country and Regis­

trations are selected.
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Create Pending Changes > 

Change Scope > Registration 

Package Set.

Medicinal Prod­

ucts

Multiselect
This field is removed from the

Create Pending Changes > 

Change Scope > Registration 

Package Set Countries.

The fields Country and Registration Package 

Sets are still available to populate. They appear 

after values for the fields Application Reviewing 

Country and Registrations are selected.

Data Administration

Data Administration Sections Added: Ennov InSight 7.3.1

The following Data Administration tables, sections, options, widgets, filters or fields were added for Ennov InSight 

7.3.1.

Data Administration Section: Submission Maintenance

Table 66: Evaluation Pathway Values

Entity Affected Field Name Value List Description

Assembly
— Region

— Applicable

DTD/Schema

— eCTD Code

— Evaluation

Pathway

— Last User

Updated

— Last Changed

Date

— Active Flag

To conform to the latest standards set by South

African Health Products Regulatory Authority (SAHPRA), 

the Evaluation Pathway Values  table is introduced.
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Database Columns

Database Columns Added: Ennov InSight 7.3.1

The following Database fields, columns and tables were added in this release.

UI Field

Name

Database Table Name Database Column Name
Database

Column

Type and

Size

Description

2nd

Attachment

Language

MGR.ATTACHMENT_TYPE LANGUAGE_TYPE_2_ID NUMBER
To support XEVMPD require­

ments, new

LANGUAGE_TYPE_2_ID

column is added to provide 

additional language for At­

tached Documents. Populat­

ed from

MGR.LANGUAGE_TYPE.

Cumulative Data Administration

Database Columns Removed: Ennov InSight 7.3.1

The following Database fields, columns and tables were removed in this release.

UI Field Name
Database Table

Name

Database

Column

Name

Database

Column Type

Description

In-Process

Rendition

Location

ODS.

PUB_SETTINGS

IN_PROCESS

_RENDITION

_LOC_ID

NUMBER
To support the default inprocess 

linking for Linking plugin (PDF) with­

out the need to access the DMS, the

IN_PROCESS_RENDITION_LOC
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_ID column is deleted from the ODS. 

PUB_SETTINGS table.

Cumulative Database Columns Ennov InSight 7.3.2 Release Notes



Chapter 4. Ennov InSight 7.3.2 Release Notes

Ennov InSight 7.3.2 Release Notes
The Release Notes contain information about updated files, new functionality, resolved issues, and any open issues 

or workarounds in this release of Ennov InSight 7.3.2.

The details in these Release Notes supersede all similar details that appear anywhere else in this release of the 

product or its other documentation. Regulatory Updates

Support for South Africa (ZA) eCTD Module 1 version 3.1.

For more information about new ZA values, extensions and rules, see:

— Ennov InSight Data Migration 7.3 > Ennov InSight 7.3.2 Updates

— Ennov InSight Publisher 7.3 > Submissions > Create eCTD Wizard > eCTD Attributes South Africa

— Ennov InSight Publisher 7.3 > Extension Type and Usage > Extension Type: Regional Folders > South Africa

— Ennov InSight Administration 7.3 > Administrative Activity > Import eCTD Applications > Prepare for Bulk eCTD 

Import > ZA 3.1 Applications

— Ennov InSight Administration 7.3 > eCTD Codes > eCTD Filing Types for ZA

— Ennov InSight Administration 7.3 > eCTD Filing Types for ZA > eCTD Sub-Filing Types for ZA

— Ennov InSight Administration 7.3 > Assembly XML Specification > m1-za v. 3.1

Note:   As the South Africa (ZA) eCTD Module 1 version 3.0 is not accepted by SAHPRA, it is no longer supported 

in Ennov InSight. The Data Administration changes to support version 3.0 have been removed and replaced with 

support for version 3.1.

Ennov InSight 7.3 COB and Known Issues
For Clarification of Behavior (COB) and Known Issues, see: COB  and Known Issues  topics under Ennov InSight 7.3 

Release Notes (Cumulative)

https://help-insight.ennov.com/CalyxRIM_7.3/ReleaseNotes/clarification_of_behavior_ennov_insight_7_3.html
https://help-insight.ennov.com/CalyxRIM_7.3/ReleaseNotes/known_issues.html


Chapter 5. Ennov InSight 7.3.3 Release Notes
The Release Notes contain information about updated files, new functionality, resolved issues, and any open issues 

or workarounds in this release of Ennov InSight 7.3.3.

The details in these Release Notes supersede all similar details that appear anywhere else in this release of the 

product or its other documentation.

eCTD 4.0

Ennov InSight 7.3.3 introduces the following enhancements for eCTD 4.0:

— Ability to create an eCTD 4.0 working assembly from the locked eCTD 3.2 assembly submitted view. At this 

moment, envelope, additional attributes, and SDK creation are not copied over.

— Tracking the long-running process in Job Requests to monitor the creation of large eCTD 4.0 assemblies.

— Ability to map eCTD 4.0 template to Assembly DTD/Schema Types in Data Administration (Assembly > Assembly 

DTD/Schema Types).

— Recalculate Checksums

— Change Submittal Status wizard

— Create eCTD wizard - Initial assembly creation. For existing assembly, additional attributes are not populated. For 

more information, see Create an eCTD Submission  under Ennov InSight 7.3.3 eCTD 4.0 Publishing  help module.

— Please note, when performing incremental publishing, follow existing best practice and generate the XML only 

when doing the final publishing. This mechanism significantly improves the performance of XML generation.

Regulatory Updates

Ennov InSight 7.3.3 now supports World Health Organization (WHO) v1.0.

For more information about new WHO values, extensions, and rules, see:

— Ennov InSight Data Migration 7.3 > Ennov InSight 7.3.3 Updates

— Ennov InSight Publishing 7.3 > Use eCTD Templates > eCTD Template Files

— Ennov InSight Publishing 7.3 > Submissions > eCTD Attributes World Health Organization

— Ennov InSight Publishing 7.3 > Extension Type and Usage > Extension Type: Regional Folders > WHO

— Ennov InSight Publishing 7.3 > Use eCTD Templates > Mapped eCTD Template Profiles

— Ennov InSight Publishing 7.3 > Extended Attributes Name, Type, and Version

— Ennov InSight Publishing 7.3 > Extension Types and Usage
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— Ennov InSight Administration 7.3 > Data Administration > Data Administration Selection Lists: Submission 

Maintenance

— Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Filing Types > eCTD Filing Types for

WHO

— Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Filing Types > eCTD Filing Types for WHO > 

eCTD Sub-Filing Types for WHO

— Ennov InSight Administration 7.3 > Assembly XML Specification > Extensions > Groups of Extensions by Version 

and Country

— Ennov InSight Administration 7.3 > Assembly XML Specification > Extensions > Folder Extensions > m1-who v.

1.0

Ennov InSight 7.3.3 now supports European Union (EU) v3.1 submissions.

For more information about new EU values, extensions, and rules, see:

— Ennov InSight Publishing 7.3 > Use eCTD Templates > eCTD Template Files

— Ennov InSight Publishing 7.3 > Extended Attributes Name, Type, and Version

— Ennov InSight Administration 7.3 > Administrative Activities> Import eCTD Applications > Prepare for Bulk eCTD 

Import

— Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Country Values

— Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Filing Types > eCTD Filing Types for EU

— Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Filing Types > eCTD Filing Types for EU > eCTD 

Sub-Filing Types for EU

— Ennov InSight Administration 7.3 > Assembly XML Specification > Groups of Extensions by Version and Country

— Ennov InSight Administration 7.3 > Assembly XML Specification > Folder Extensions > m1-additional > 

m1additional v. 3.1

— Ennov InSight Administration 7.3 > Assembly XML Specification > Folder Extensions > envelope > envelope v.

3.1

— Ennov InSight Administration 7.3 > eu_module_1_country_specific_information > 

eu_module_1_country_specific_information v.3.1

— Ennov InSight Administration 7.3 > Folder Extensions > m1-responses > m1-responses v. 3.1

— Ennov InSight Administration 7.3 > Folder Extensions > m1-3-1-spc-label-pl > m1-3-1spc-label-pl v. 3.1
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— Ennov InSight Administration 7.3 > Administrative Activities > Manage eCTD and eCTD 4.0 Templates > eCTD 

Templates

Ennov InSight 7.3.3 now includes assembly templates for China eSubmissions.

IDMP Updates

Note:   The IDMP Data Generation, IDMP Data Visualization, IDMP Validation in Job Requests and FHIR message 

functionalities that were implemented as Proof of Concept (POC) in Ennov InSight 7.3 are updated in Ennov InSight

7.3.3. This release includes enhancements to the Proof of Concept (POC). To see and use the enhancements, rerun 

the IDMP Data Generation wizard..

To conform to the latest standards set by International Organization for Standardization (ISO) and also improve the 

user experience, Ennov InSight now includes the following updates:

— New attributes in Data Administration (Other > Data Carrier Identifier Source Values, Registration Maintenance > 

Data Carrier Type, Product Detail Set Maintenance > Manufacturer Values > Manufacturing Authorization Reference 

Number).

— Multiple Data Administration tables moved from Registration Maintenance  to Application Maintenance.

Ennov InSight RIM 7.3 Release Notes Cumulative

— New Alternate IDMP Reference Active Ingredient attribute on Manufactured Item Reference Active

Ingredient  and Pharmaceutical Product Reference Active Ingredient. For both pharmaceutical products and 

manufactured items, the same substance values can be selected multiple times for the Active Ingredient Name field 

if the Alternate IDMP Active Ingredient Name field is configured via overrides and contains a unique value.

— New Attached Document Country attribute on the Attached Documents  page.

— New Device Quantity Unit of Measurement attribute on the PDS Packaging Detail  page.

— The Device Quantity Unit attribute renamed to Device Quantity Unit of Presentation on the PDS Packaging Detail 

page.

— The length of the Manufactured Item Characteristics/Description value on the Manufactured Item and 

Manufactured Items tab on the Component is increased.

— Multiple fields renamed for Registrations  entity.

IDMP POC Support

— Additional and updated entities and data points with the improved search and filter functionality and the ability to 

view validation messages from Job Requests on the IDMP Data Visualization page. When data does not meet the 

validation criteria, entity fields are marked with a symbol denoting errors or warnings.

— Job Requests updates for IDMP Data Generation in Job Requests > Search Results and Excel reports.
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Product Search

The improved Product Search  selection widget enables to filter products using specific search criteria in the following 

entities and wizards: — Entities:

• Applications (Create Application > Associated Products, Application Attributes > Associate/ Dissociate 

Products > Products)

• Events (Create Event > Products, Event Attributes > Associate/Dissociate Products > Associated Products)

• Product Registration (Application Attributes > Create Registration > Products, Registration Attributes > 

Associate/Dissociate Products > Products)

— Wizards:

• Create Application (Enter values for new application > Associated Products on Create Application  and Create 

Event  pages of the wizard)

Support of Special Characters

Ennov InSight 7.3.3 supports the use of more special characters in Documentum and File system. See: Ennov InSight 

7.3 > Special Characters

Privacy Policy

To ensure compliance with data protection requirements, a link to the Privacy Policy  is added to the Ennov InSight 

application, available from the Username menu on the top-right corner.

New in Ennov InSight 7.3.3: Common Functionality
This table shows new features and enhancements of Ennov InSight 7.3 functionality.

eCTD 4.0

To support eCTD 4.0, the following features are added:

Affected Area Update Benefit

Data Administration
The following updates have been made to 

Data Administration:

— eCTD 4.0 Template Mapping in

Assembly DTD/Schema Types. See Data Ad­

ministration Tables Updated: Ennov InSight 

7.3.3

To provide flexible configura­

tion while updating submis­

sions from eCTD 3.2 to eCTD 

4.0, new attributes are

added to Data

Administration.

IDMP

https://EN.ENNOV.COM/PRIVACY-POLICY/
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To capture additional data elements for European Medicine Agency (EMA) implementation of IDMP.

Affected Area Update Benefit

Entities/Entity 

tabs
To confirm to the latest IDMP specification, the following 

tab has been updated:

— Attached Documents. See Entity Fields, Columns and 

Options Added: Ennov InSight 7.3.3

The ability to view/add countries 

associated with the selected med­

icinal product on the Attached 

Documents  page. The ability to 

create attached documents in ac­

cordance with the latest European 

Medicine Agency (EMA) IDMP re­

quirements.

Ennov InSight RIM 7.3 Release Notes

Cumulative

New in Ennov InSight 7.3.3: Common Functionality

Affected Area Update Benefit

Data

Administration

To conform to the latest IDMP specification, the following 

changes have been made to Data Administration:

— New fields added to Product Detail Set Maintenance > 

Manufacturer Values >

Manufacturing Authorization Reference Number

— New Data Carrier Identifier Source Values  table added 

to Data Administration > Other

— New Data Carrier Identifier Source value added to Regis­

tration Maintenance > Data Carrier Type

— Medicinal Product Action/Submission Statues

Values  table moved from Registration

Maintenance  to Application Maintenance

— Medicinal Product Name Part Type Values  table moved 

from Registration Maintenance  to Application Maintenance

— Medicinal Product Type Values  table moved from Regis­

tration Maintenance  to Application Maintenance

The ability to populate Data Ad­

ministration values in accordance 

with the latest European Medi­

cine Agency (EMA) IDMP require­

ments.
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See Data Administration Tables Added: Ennov InSight 

7.3.3, Data Administration Table Updated: Ennov InSight 

7.3.3, Data Administration Table

Removed:Ennov InSight 7.3.3

New in Ennov InSight 7.3.3: Registrations
The new features and enhancements for Registration functionality are as follows.

Affected Area Update Benefit

Applications These entities are updated to include the The widget enables effective

Events improved Product Search  selection widget. and faster product search in these 

entities.

Product

Registration

See: Entity Fields, Columns and Options Updated: En­

nov InSight 7.3.3

Create Applica­

tion wizard

Affected Area Update Benefit

Medicinal

Product Actions

Changes to IDMP include updates for the following:

— New and updated nodes on the IDMP Data Visualiza­

tion  page. See Ennov InSight IDMP> IDMP Data Visual­

ization Attributes.

— New field on the Attached Documents  page.

See:

— Entity Fields and Columns Added: Ennov

InSight 7.3.3

— Entity Fields and Columns Updated: Ennov InSight 

7.3.3

— Job Requests updates.

See: Job Requests Updated: Ennov InSight 7.3.3

To conform to the latest standards 

set by International

Organization for

Standardization (ISO) and also im­

prove the user experience to capture 

IDMP data in Ennov InSight in prepa­

ration for submitting IDMP data to 

EMA.
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Registrations
To support the latest IDMP requirements, changes are 

made to the following Registrations  tabs:

— Package Sets

— Package Descriptions

— PDS-Manufacturer Details

— Alternate IDMP Reference Active Ingredient field 

added

See: Entity Fields, Columns and Options Updated:

Ennov InSight 7.3.3

To conform to the latest standards 

set by International

Organization for

Standardization (ISO) and also im­

prove the user experience to capture 

IDMP data in Ennov InSight in prepa­

ration for submitting IDMP data to 

EMA.

Ennov InSight RIM 7.3 Release Notes Cumulative

Affected Area Update Benefit

Manufactured 

Items
To support the latest IDMP requirements, the Manufac­

tured Items  page now includes the following updates:

— Manufactured Item Characteristics/

Description field length increased

— If Alternate IDMP Reference Active Ingredient is con­

figured via overrides and populated with a unique value, 

the Active Ingredient field on the Create Active Ingredi­

ent  page allows users to select same substance values 

multiple times.

See: Entity Fields, Columns and Options Added: Ennov 

InSight 7.3.3

Entity Fields, Columns and Options Updated: Ennov 

InSight 7.3.3

To conform to the latest standards 

set by International

Organization for

Standardization (ISO). The update al­

so improves user experience of cap­

turing IDMP data in Ennov InSight in 

preparation for submitting IDMP da­

ta to EMA.

Pharmaceutical 

Products
To support the latest IDMP requirements, changes are 

made to the following:

— New Alternate IDMP Reference Active

Ingredient field added on the Reference Active Ingredi­

ent  page

To conform to the latest standards 

set by International

Organization for

Standardization (ISO). The update al­

so improves user experience of cap­
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— If Alternate IDMP Reference Active Ingredient is con­

figured via overrides and populated with a unique value, 

the Active Ingredient field on the Create Active Ingredi­

ent  page allows users to select same substance values 

multiple times.

See: Entity Fields, Columns and Options Added:

Ennov InSight 7.3.3

turing IDMP data in Ennov InSight in 

preparation for submitting IDMP da­

ta to EMA.

Affected Area Update Benefit

PDS Details
To support the latest IDMP requirements, the PDS Pack­

aging Detail  page now includes the following updates:

— New field added Device Quantity Unit of

Measurement

— The Device Quantity Unit field is renamed to Device 

Quantity Unit of Presentation

See: Entity Fields, Columns and Options Added: Ennov 

InSight 7.3.3  and Entity Fields, Columns and Options 

Updated: Ennov InSight 7.3.3

To conform to the latest standards 

set by International

Organization for

Standardization (ISO). The update al­

so improves user experience of cap­

turing IDMP data in Ennov InSight in 

preparation for submitting IDMP da­

ta to EMA.

New in Ennov InSight 7.3.3: Publisher
New features and enhancements for Publishing functionality are listed below.

Affected Area Update Benefit

Assembly
To expand the eCTD 4.0 functional­

ity, Ennov InSight provides the abili­

ty to create an eCTD 4.0 working as­

sembly from the locked eCTD 3.2.2 

assembly submitted view. See:

— Ennov InSight Publisher 7.3: 

eCTD 4.0 > Submissions > Cre­

ate Working Assembly from Locked 

eCTD 3.2.2 Assembly

To ensure forward compatibility with 

upcoming implementations and 

maintain the functionality of the ex­

isting submission elements, the as­

sembly view and features are updat­

ed accordingly.
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— Ennov InSight Administration > 

Data Administration > Assembly 

Maintenance: Assembly Values

Ennov InSight RIM 7.3 Release Notes

Cumulative New in Ennov InSight 7.3.3: Publisher

Affected Area Update Benefit

Assembly
To expand the eCTD 4.0 functionality, 

the following options are now avail­

able: — Recalculate Checksums

— Change Submittal Status wizard

— Create eCTD wizard

See:

— Ennov InSight Publisher 7.3:

eCTD 4.0 >Assemblies>

Recalculate Checksums

— Ennov InSight Publisher 7.3: 

eCTD 4.0 >Submissions:

• Ennov InSight Publisher

7.3: eCTD 4.0 >Lifecycle>

Modify Submission

Statuses

• Ennov InSight Publisher

7.3: eCTD 4.0 > Life

Cycle> Lock Sequence

Assemblies

— Entity Fields, Columns and

Options Updated: Ennov

To expand the eCTD 4.0 functionality 

and maintain the functionality of the 

existing submission elements, the 

wizards and features are updated ac­

cordingly.
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InSight 7.3.3

— Ennov InSight Publisher 7.3: 

eCTD 4.0 > Submissions > Create 

eCTD Wizard:

• Ennov InSight Publisher

7.3: eCTD 4.0 > Submissions> Cre­

ate eCTD Wizard> Create eCTD 4.0 

Submission

Resolved Issues: Ennov InSight 7.3.3
The following issues reported to Technical Support have been resolved. Issues are listed in descending order by their 

tracking numbers. Customer incident numbers that were recorded when the issues were reported are included in 

brackets [#####] following the tracking number.

If an issue was resolved in a previously released sub-minor build, that build number is included.

Common

Issue Sub-Minor Build Description

DE32097 N/A Trying to edit or deactivate a Regulatory Entitlement Type value re­

sulted in an error. This issue is resolved. Now, you can edit or deacti­

vate a Regulatory Entitlement Type value successfully.

DE31877 N/A For a Documentum Virtual Document (VD) assigned to an assembly, 

changes made to its structure (for example, adding a new child doc­

ument) were not displayed after a VD was reassigned. This issue is 

resolved. Now, a VD structure correctly displays the changes after a 

VD is reassigned.

DE31815,

[TASK0925392]

If Documentum Virtual Document (VD) with child elements was as­

signed to an assembly, the display order of assembly elements was 

not in the same order as in Documentum. This issue is resolved. 

Now, the assigned VD retains the original order defined in Documen­

tum.

DE31799,

[INC0321912,

TASK0869957]

N/A Trying to assign a virtual document using DMS Search resulted in a 

placeholder being displayed instead of the expected content. This 

issue is resolved. Now, a virtual document assigned using DMS 

Search is displayed correctly.
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DE31795 N/A Missing indexes in the database caused performance issue when 

trying to save entities after editing. This issue is resolved. Run the 

7_3_3_0066_0058.zip script in addition to the main scripts during 

the migration procedure. The additional script must be run after the 

main script.

DE31757;

[INC0321912,

TASK0869957]

N/A If the Documentum file names included invalid characters: \/:*?\"<>|, 

performing some actions in assembly resulted in an error. This is­

sue is resolved. Invalid symbols in file names are now automatically 

deleted, and there are no errors when working with assembly.

Issue Sub-Minor Build Description

DE31437 N/A The API queryFor method failed to substitute the entityXMLMap­

pingId, the applicationCategoryId and the associatedCountries fields 

values with their IDs for Application Type Values, Applicant ID Val­

ues and Secondary Event Type Values. These entities were not cre­

ated and an error was displayed. This issue is resolved. Now, the 

Create or Update operations are successfully performed specifying 

the fields with IDs.

DE30586 N/A
For the applications with EU Clinical Trial Regulation application 

type and EU CTR procedure type, the values for the following fields 

were not saved if populated on the Add Application Countries  page:

— Local Start of Trial Date

— Local First Visit of First Subject Date

— Local End of Recruitment Date

— Local End of Trial Date

— Local Temporary Halt Date

— Local Restart of Temporarily Halted Trial Date

— Local Early Termination/Withdrawal/Suspension Date

This issue is resolved. Now, the populated values are saved.

DE27309 N/A
When you select Global Project Plan > Modify Substance or Add 

Substance from Project Attributes  page for the Update Product De­

tails Sets project type, not all the fields are displayed in comparison 

to the Substance page in PDS.
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This issue is resolved. Now, all the fields are displayed.

Publishing

Issue Sub-Minor Build Description

DE32081 N/A For a document assigned to an assembly and its file type extension 

(such as .pdf) removed, running Prepare documents for linking and 

then running the Edit document links failed to download the docu­

ment. This issue is resolved. Now, the document is downloaded suc­

cessfully.

DE31792 N/A In a study report datasets folder, if leafs have same names, using 

Recalculate Checksums from an assembly root results in same 

checksums for the leafs with same names. This issue is resolved. 

Now, even if the leafs have same names, the checksums will be dif­

ferent.

Issue Sub-Minor Build Description

DE31551 N/A Using the Recalculate Checksums option on a published eCTD as­

sembly that contained a period in the Application Code value gener­

ated extra files in the output location instead of updating the exist­

ing ones. This issue is resolved. Now, the existing files are updated.

DE31473 N/A eCTD 4.0: Performance issue experienced when using Electronic 

Publish > All Leaf Elements and XML is resolved. The performance 

is improved.

DE31468 N/A
Trying to perform the Recalculate Checksums operation for an up­

dated output document more than once in a short span of time 

failed and resulted in an error on the

Assembly Attributes  page. The same issue existed for DMS Synchro­

nization. In this case the Bound Version field failed to be updated. 

These issues are resolved. The Recalculate Checksums and DMS 

Synchronization operations are successfully performed.

DE31457 N/A
When trying to simultaneously generate and render TOC within Pre­

pare for Publishing job  or separately within a short period of time, 

the job failed with the following error messages:

— Resource not found

— Unable to get rendition
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This issue is resolved. Now, you can simultaneously generate and 

render TOC more than once within a short period of time.

DE31448 N/A Trying to search for entities using criteria in the API /query endpoint 

resulted in an error for many entities from the Application Mainte­

nance section. This issue is resolved. Now, the entities are returned 

with parameters that match the specified criteria.

DE31130 N/A Creating an in-process link in an assembly for the second time re­

sulted in the document not opening in Adobe Acrobat or in Link­

ing plug-in (PDF).This issue is resolved. Now, you can create an in-

process link in an assembly for the second time and open the docu­

ment in Adobe Acrobat or in Linking plug-in (PDF).

Issue Sub-Minor Build Description

DE30901 N/A After a document is assigned to an assembly from the SMB file 

share, if that document in the SMB file share is deleted, the docu­

ment icon and the Assignment status are only updated after a delay. 

This issue is resolved. Now, the document icon and the Assignment 

status are updated when the DMS synchronization window closes.

Registrations

Issue Sub-Minor Build Description

DE32280

[TASK1600548]

N/A When Oracle is updated, previously working actions with some du­

plicating values may not work correctly. For example, trying to close 

an Event, having a PDS Substance with the same Substance Name 

and same Substance Role but with a different Substance Type, as 

approved resulted in an error. The issue is resolved. This issue is re­

solved.

DE32162 N/A The XEVMPD acknowledgment file failed to auto upload when put 

on SMB fileshare. This issue is resolved. Now, the XEVMPD ac­

knowledgment file auto uploads.

DE31861 N/A
The SPOR value was displayed in the IDMP Data

Visualization Tree for Manufactured Item and Pharmaceutical Prod­

uct - Substance. This issue is resolved. Now, the SPOR value is not 

displayed in the Tree.

DE31582 N/A
Trying to view Action values (U, I, or D) for the Product
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Detail-Manufacturer  entity type in the Entity Audit Trail > Search Re­

sults table resulted in an error. This issue is resolved. Now, all Action 

values are successfully displayed in the Search Results table.

Issue Sub-Minor Build Description

DE28575 N/A
The performance of the Product Selection widget in the following ar­

eas has been improved by introducing the new Product Search wid­

get:

— Create Application from Applications  tab under PF Attributes.

— Create Application Wizard  (both Application and Event creation).

— Associate/Disassociate Product under Products  tab on Applica­

tion Attributes  page.

— Create Event on Application Attributes  page.

— Associate/Disassociate Product under Products  tab on Event At­

tributes  page.

— Create Registration on Application Attributes  page.

— Associate/Disassociate Product under Products  tab on Registra­

tion Attributes  page.

Entity Fields

Entity Fields, Columns and Options Added: Ennov InSight 7.3.3

The following tables describe fields and columns that were added in this release. These include the fields and column 

that were added to support IDMP data capture and eCTD 4.0 publishing standards.

Medicinal Product Action

Table 67: IDMP Data Visualization

Field/Column/ 

Option Name

Field Type Description Business Rules

N/A N/A
The IDMP Data

To conform to the latest IDMP specification re­

leased and to improve the user experience, the vali­

dation messages from Job Requests are also avail­

able from the IDMP Data Visualization  page.
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Visualization  page now in­

cludes the validation mes­

sages from Job Requests.

Table 68: Attached Documents

Field/Column/ Op­

tion Name

Field 

Type

Description Business Rules

Attached

Document

Country

Drop­

down

The Attached Docu­

ments page  now in­

cludes the respective 

field.

New Attached Document Field is displayed under the At­

tached Document Effective Date. Values for the new field 

are taken from the Application Maintenance > Countries 

Values DA List.

The new field can be populated on the Create Attached 

Document  page and modified on the Edit Attached Docu­

ment  page.

Manufactured Item

Table 69: Reference Active Ingredient

Field/Column/ 

Option Name

Field Type Description Business Rules

Alternate

IDMP

Reference

Active

Ingredient

Selection 

widget, 

drop-down

The following pages are 

updated to include this 

field:

— Create Reference Active 

Ingredient

— Reference Active Ingre­

dient Attributes

— Modify Reference Active 

Ingredient

Attributes

The Alternate IDMP Reference Active Ingredient field 

is hidden OTB and only available if unhidden using 

overrides.

This field can be configured as a substance selection 

widget with all active values from Data Administra­

tion > Substance Values, or as drop-down list with the 

values from the Component > Reference Active Ingre­

dient.

Only one value can be selected for the Alternate IDMP 

Reference Active Ingredient field and it can not be up­

dated.

Pharmaceutical Product

Table 70: Reference Active Ingredient
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Field/Column/ 

Option Name

Field Type Description Business Rules

Alternate

IDMP

Reference

Active

Ingredient

Selection 

widget, 

drop-down

The following pages are 

updated to include this 

field:

— Create Reference Active 

Ingredient

— Reference Active Ingre­

dient Attributes

— Modify Reference Active 

Ingredient

Attributes

The Alternate IDMP Reference Active Ingredient field 

is hidden OTB and only available if unhidden using 

overrides.

This field can be configured as a substance selection 

widget with all active values from Data Administra­

tion > Substance Values, or as drop-down list with the 

values from the Component > Reference Active Ingre­

dient.

Only one value can be selected for the Alternate IDMP 

Reference Active Ingredient field and it can not be up­

dated.

PDS Details

Table 71: Packaging Details

Field/Column/ Op­

tion Name

Field Type Description Business Rules

Device Quantity

Unit of

Measurement

Drop­

down
The following pages now in­

clude the respective field:

— PDS Packaging > Add 

Packaging

— PDS Packaging > Edit

Packaging

— PDS Packaging >

Package Detail

Attributes

Values for the Device Quantity Unit of

Measurement field are taken from the Other > Units 

of Measurement Values Data Administration list.

The Device Quantity Unit of Measurement field can 

not be populated if the Device Quantity Unit of Pre­

sentation field is already populated. Trying to popu­

late the field in this case results in the You can set 

only one Device Quantity Unit type warning mes­

sage.

Entity Fields, Columns and Options Updated: Ennov InSight 7.3.3

The following tables describe fields, columns and options that were modified in this release. These include the fields 

and column that were added to support IDMP data capture, eCTD 4.0 publishing standards.
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Applications

Field/

Column/

Option Name

Field Type Description Business Rules

Associated 

Products

Selection 

widget
For the following pages, 

this field is updated with im­

proved Product Search  selec­

tion widget:

— Applications > Create Ap­

plication

— Application Attributes

> Associate/Dissociate

Products

The improved Product Search  selection widget al­

lows to filter search results using the following crite­

ria: — All Products Family

— Family Code

— Family Name

— Family Type

— Product Code

— Product Name

— Product Status

The Family Name filter remains blank if an applica­

tion is associated with multiple product families.

By default, only 20 products are displayed per page. 

However, this number can be increased via over­

rides. To configure overrides, please

contact your Business Support

Representative.

Events

Field/

Column/

Option

Name

Field Type Description Business Rules
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Products Selection 

widget
The improved Product 

Search  selection widget is 

added to the following pages:

— Events > Create

Application

— Event Attributes > Asso­

ciate/Dissociate Products

With the improved Product Search  selection widget, 

you can filter search results using the following criteria: 

— All Products Family

— Family Code

— Family Name

— Family Type

— Product Code

— Product Name

— Product Status

The Family Name filter remains blank if an application 

is associated with multiple product families.

By default, only 20 products are displayed per page. 

However, this number can be increased via overrides. 

To configure overrides, please contact your Business 

Support Representative.

Field/

Column/

Option Name

Field Type Description Business Rules

PDS Package 

Status Date
Read-

only text

The respective field is renamed to PDS 

Package Set Status Date on the follow­

ing pages:

— Modify Registration Package Set

Association

— Registration-Package Set

Attributes

— Entity Audit Trail

To conform to the latest standards set by 

International Organization for Standardiza­

tion (ISO) and also improve the user experi­

ence, the field

name is also renamed on the

Registration-Package Set tab.

Product Registration
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Field/

Column/

Option

Name

Field Type Description Business Rules

Products Selection 

widget
The improved Product Search 

selection widget is added to 

the following pages:

— Application Attributes

> Create Registration

— Registration Attributes

> Associate/Dissociate

Products

With the improved Product Search  selection widget, 

you can filter search results using the following crite­

ria: — All Products Family

— Family Code

— Family Name

— Family Type

— Product Code

— Product Name

— Product Status

The Family Name filter remains blank if an applica­

tion is associated with multiple product families.

By default, only 20 products are displayed per page. 

However, this number can be increased via overrides. 

To configure overrides, please contact your Business 

Support Representative.

Registrations

Table 72: Registration-Package Set Table 73: Package Descriptions

Field/

Column/

Option Name

Field 

Type

Description Business Rules

Package

Description

Box
The respective field is renamed to PMP Package 

Description on the following pages:

— Create Package Description page

To conform to the latest standards 

set by International Organization for 

Standardization (ISO) and also im­

prove the user experience, the exist­
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— Modify Package Description

— Package Set-Package Description

Attributes

— Entity Audit Trail

Also, the renamed field is now displayed in the 

Search Results table when using the Registration 

Package Set > Entity History Query option.

ing fields have also been renamed 

on the Package Descriptions tab.

Language Select
The respective field is renamed to PMP Package 

Description Language on the following pages:

— Create Package Description

— Modify Package Description

— Package Set-Package Description

Attributes

— Entity Audit Trail

Also, the renamed field is now displayed in the 

Search Results table when using the Registration 

Package Set > Entity History Query option.

To conform to the latest standards 

set by International Organization for 

Standardization (ISO) and also im­

prove the user experience, the exist­

ing fields have also been renamed 

on the Package Descriptions tab.

Table 74: PDS-Manufacturer Details

Field/Column/Option

Name

Field 

Type

Description Business Rules

— Manufacturer Operation 

Start

Date

— Manufacturer

Operation Stop Date

Date
The fields are renamed to the

Manufacturing Operation Start

Date and Manufacturing

Operation End Date respectively on 

the following pages:

— Add Manufacturer

— Edit Manufacturer

To conform to the latest standards 

set by International Organization for 

Standardization (ISO) and also im­

prove the user experience, the exist­

ing fields have been updated on the 

PDSManufacturer Details  page.
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— Manufacturer Detail Attributes

— Entity Audit Trail

Pharmaceutical Product

Table 75: Active Ingredient

Field/Column/ Op­

tion Name

Field 

Type

Description Business Rules

Active

Ingredient Name

Drop­

down

On the Create Active Ingredient  page, the 

field allows users to select the same sub­

stance value multiple times even if it was 

previously used to create Active Ingredi­

ent.

This functionality is only available if 

the Alternate IDMP Active Ingredient 

Name field is configured via overrides 

and contains a unique value.

Manufactured Items

Field/Column/Option

Name

Filed Type Description Business Rules

Manufactured Item

Characteristics/

Description

Text
On the following pages, the 

field length is increased 

to allow entering/display­

ing of up to 4000 charac­

ters when using single-byte 

character sets (one byte 

per character):

— Create Manufactured 

Item

— Modify Manufactured

Item

— Manufactured Item

Attributes

— Entity Audit Trail

To conform to the latest 

standards set by Interna­

tional

Organization for Standard­

ization (ISO) and also im­

prove the user experience, 

the maximum field length 

is increased. New rule is 

only applicable for sin­

gle-byte character sets.
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Active Ingredient Name Drop-down
On the Create Active In­

gredient  page, the field al­

lows to select the same 

substance value multiple 

times even if it was previ­

ously used to

create Active Ingredient.

This functionality is only 

available if the

Alternate IDMP Active In­

gredient Name field is con­

figured via overrides and 

contains a unique value.

PDS Details

Table 76: PDS Packaging Detail

Field/

Option/

Column

Name

Field Type Description Business Rules

Device

Quantity

Unit

Drop­

down
The respective field is 

now renamed to the 

Device Quantity

Unit of Presentation.

To conform to the latest standards set by International Organi­

zation for Standardization (ISO) and also improve the user ex­

perience, the Device Quantity Unit field is renamed. Also, the val­

ues for the Device Quantity Unit field will not be populated if the 

Device Quantity Unit of Measurement field is already populated. 

Trying to populate the field in this case results in the You can 

set only one Device Quantity Unit type warning message dis­

played.

Wizards

Table 77: Create Application

Field/

Column/

Option Name

Field Type Description Business Rules

Associated 

Products

Selection 

widget
For the following pages, this 

field is updated with improved 

New Product Search  selection widget allows to fil­

ter search results using the following criteria:

— All Products Family
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Product Search  selection wid­

get:

— Events > Create Event

— Event Attributes > Asso­

ciate/Dissociate

Products

— Family Code

— Family Name

— Family Type

— Product Code

— Product Name

— Product Status

The Family Name filter remains blank if an applica­

tion is associated with several product families.

By default, only 20 products are displayed per 

page. However, this number can be increased via 

overrides.

Table 78: Create eCTD

Field/Column/ 

Option Name

Field Type Description Business Rules

Copy TOCs and 

Special

Sheets

Check 

box

This field is not available in the Create eCTD 

wizard, when the submissions are created 

from the sequence which has the eCTD 4.0 

value selected in the Sequence Standard 

Type.

To expand the eCTD 4.0 functionality 

and maintain the functionality of the 

existing submission elements, the 

wizards and features are

Template Selec­

tion

Drop­

down list

This field is updated to load the correspond­

ing eCTD 3.2 or eCTD 4.0 templates based on 

the region, values selected in the Sequence 

Standard Type and defined configuration.

updated accordingly.

Data Administration Tables

Data Administration Tables Added: Ennov InSight 7.3.3

The following Data Administration tables were added for Ennov InSight 7.3.3 release.

Data Administration: Other

Table 79: Data Carrier Identifier Source Values

Entity
Field Name Value List Description
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Affected

N/A
— Data Carrier Identifier Source

— RMS Term ID

— RMS Modified On

— RMS Status

— Last User Updated

— Last Changed Date

— Active Flag

— Term ID

— Term Name

— Description

To conform to IDMP requirements, the Data Carrier Identifier 

Source Values table with the respective fields and RMS tab 

is introduced in Data

Administration. The list is mapped to the SPOR Master Lists 

> Source of Information.

The Data Carrier Identifier Source value can be modified us­

ing Edit option.

Data Administration: Registration Maintenance

Table 80: Data Carrier Type Values

Entity Affected Field Name Value List Description

Data Carrier Type 

Values
Data Carrier

Identifier Source

To conform to IDMP requirements, the Data Carrier Type Values ta­

ble now includes the respective field. Values for it are taken from 

Other > Source of Information Values.

Ennov InSight RIM 7.3 Release Notes

Cumulative Data Administration Tables Added:

Data Administration Tables Updated: Ennov InSight 7.3.3

Data Administration tables were updated for Ennov InSight 7.3.3 release.

Data Administration Section: Application Maintenance

Table 81: Medicinal Product Action/Submission Status Values

Entity Affected Column/Field Name Value List Description

Medicinal Product — Status Name To conform to the latest IDMP requirements, the
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Action /

Submission Status

Values

— Last User Updated

— Last Changed Date

— Active Flag

Application Maintenance  DA List is updated to include the Med­

icinal Product Action/Submission Status Values  table with re­

spective fields/columns. Values for the Status Name field can 

now only be populated via Application Maintenance  and not 

Registration Maintenance.

Table 82: Medicinal Product Name Part Type Values

Entity Affected Column/Field Name Value List Description

Medicinal

Product Name

Part Type

Values

— Medicinal Product Name Part 

Type Name

— RMS Term ID

— RMS Modified On

— RMS Status

— Last User Updated

— Last Changed Date

To conform to the latest IDMP requirements, the Applica­

tion Maintenance  DA List is updated to include the Medicinal 

Product Name Part Type Values  table with respective fields/

columns. Values for the Medicinal Product Name Part Type 

Name field can now only be populated via Application Main­

tenance  and not Registration Maintenance.

Table 83: Medicinal Product Type Values

Entity

Affected

Column/Field Name Value List Description

Medicinal

Product Type

Values

— Medicinal Product Type Name

— Medicinal Product Type

Code

— RMS Term ID

— RMS Modified On

— RMS Status

— Last User Updated

— Last Changed Date

— Active Flag

To conform to the latest IDMP requirements, the Applica­

tion Maintenance  Data Administration List is updated to in­

clude the Medicinal Product Type Values  table with respective 

fields/columns. Values for the fields Medicinal Product Type 

Name and Medicinal Product Type Code can now only be pop­

ulated only via Application Maintenance  and not Registration 

Maintenance.
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Ennov InSight RIM 7.3 Release Notes

Cumulative Data Administration Tables Updated:

Data Administration: Assembly

Table 84: Assembly DTD/Schema Types

Entity Affected Field Name Value List Description

Assembly
eCTD 4.0 Tem­

plate

Mapping

To determine fields and settings transition while migrating 

to eCTD 4.0, the Assembly DTD/Schema Types  table now 

includes this field.

Data Administration Section: Product Detail Set Maintenance

Table 85: Manufacturer Values

Entity Affected
Field/Column

Name

Value List Description

Manufacturer
— Function

Types

— Substances

— Status Type

— Status Date

To conform to IDMP requirements, the

Manufacturing Authorization Reference Number  table 

now includes these these fields.

Data Administration Tables Removed: Ennov InSight 7.3.3

Data Administration tables were removed for Ennov InSight 7.3.3 release.

Data Administration Section: Application Maintenance

Table 86: Medicinal Product Action/Submission Status Values

Entity Affected Column/Field Name Value List Description

Medicinal Product

Action / Submission

— Status Name

— Last User Updated

To conform to the latest IDMP requirements, the Medici­

nal Product Action / Submission Status Values  table is now 

removed from Data Administration > Registration Mainte­

nance.
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Status Values — Last Changed Date

— Active Flag

Ennov InSight RIM 7.3 Release Notes

Cumulative Data Administration Tables Removed:

Table 87: Medicinal Product Name Part Type Values

Entity Affected Column/Field Name Value List Description

Medicinal Product

Name Part Type

Values

— Medicinal Product Name Part

Type Name

— RMS Term ID

— RMS Modified On

— RMS Status

— Last User Updated

— Last Changed Date

To conform to the latest IDMP requirements, the 

Medicinal Product Name Part Type Values  table 

is now removed from Data Administration > Reg­

istration Maintenance.

Table 88: Medicinal Product Type Values

Entity Affected Column/Field Name Value List Description

Medicinal

Product Type

Values

— Medicinal Product Type Name

— Medicinal Product Type Code

— RMS Term ID

— RMS Modified On

— RMS Status

— Last User Updated

— Last Changed Date

— Active Flag

To conform to the latest IDMP requirements, the 

Medicinal Product Type Values  table is now

removed from Data Administration > Registration 

Maintenance.

Ennov InSight RIM 7.3 Release Notes

Cumulative Data Administration Tables Removed:
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Query Fields

Query Fields

Query Fields and Columns Updated: Ennov InSight 7.3.3

The following table describes columns that were added with Ennov InSight 7.3.3

Entity Audit Trail Query

Field/Column Name Field 

Type

Description

Attached Document 

Country

N/A The respective column is displayed in the Entity Audit > Search Results > 

Query table available after Action column value on Search Results is select­

ed.

Ennov InSight RIM 7.3 Release Notes

Cumulative Query Fields and Columns Updated:

Job Requests

Job Requests

Job Requests Updated: Ennov InSight 7.3.3

The following table describes the job requests and their options added and updated with the release of Ennov InSight 

7.3.3.

Job Requests

Field/

Column/

Option

Name

Field 

Type

Description

Export to Ex­

cel

Option To improve user experience and report readability, all the tags are excluded in the Excel 

report from the Job Requests for IDMP Data Generation wizard.

Job Name Text
The following Job status messages under IDMP Data Generation Initial Flow value in 

Job Requests > Search Results are now included to provide clarity of the Job results:
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— Completed with Warnings Job Status.

— Error messages that indicate multiple values are assigned to an entity.

— Error messages that indicate missing SPOR values for Data Administration entity.

— Error messages that indicate inconsistent or empty values for repeatable entities.

— Error message that indicates inconsistencies in values combinations.

— Error and warning messages that indicate missing substance, and active ingredients 

values.

— Warning messages that indicate some missing values for CP applications, registra­

tions, and medicinal products.

Job Name Text To ensure forward compatibility with future implementations for eCTD 4.0, the column 

in Job Requests > Search Results now includes the Create Forward Compatibility as­

sembly value when an eCTD 4.0 assembly is created from the locked eCTD 3.2 assem­

bly submitted view.

Job Name Text
To expand the eCTD 4.0 functionality, the column in Job Requests > Search

Results now includes the Recalculate Checksums for: <node name> value for eCTD 4.0 

that recalculates checksums for content that has been changed post publishing.

Ennov InSight RIM 7.3 Release Notes

Cumulative

Job Requests Updated: Ennov InSight

7.3.3

Database Columns

Database Columns Added: Ennov InSight 7.3.3

The following Database fields, columns and tables were added in this release.

UI Field Name
Database Table

Name

Database Column

Name

Database Col­

umn Type and 

Size

Description

Attached
MGR.ATTACHMEN 

T_TYPE

COUNTRY_ID NUMBER
The COUNTRY_ID
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Document Country column is added to the

MGR.ATTACHMENT_TYP

E table.

Attached

Document Country

MGR.ACTION_ATT 

ACHMENT

COUNTRY_ID NUMBER
The COUNTRY_ID

column is added to the 

MGR.ACTION_ATTACH 

MENT table.

Alternate IDMP Ac­

tive Ingredient

MGR.XPHARMA_P 

RODUCT_REF_AI

ALTERNATE_REF_ 

SUBSTANCE_ID

NUMBER
The

ALTERNATE_REF_SUBS 

TANCE_IDcolumn is added 

to the

MGR.XPHARMA_PRODU

CT_REF_AI table

Alternate IDMP Ac­

tive Ingredient

MGR.MI_REF_AI ALTERNATE_REF_ 

SUBSTANCE_ID

NUMBER
The

ALTERNATE_REF_SUBS 

TANCE_IDcolumn is added 

to the

MGR.MI_REF_AI table.

N/A
ODS.MIGRATION_

ASSEMBLY_TEMPL

ATE_ID

REFERENCED_DT D_­

TYPE

NUMBER
The new

REFERENCED_DTD_TYP

E column is added to the

ODS.MIGRATION_ASSE 

MBLY_TEMPLATE_ID table.

N/A
RAWSTAGE.ENTIT

Y_INSTANCE_FIEL

D_VALUE

RAW_VALUE CLOB
The new RAW_VALUE

column is added to the 

RAWSTAGE.ENTITY_IN 
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STANCE_FIELD_VALUE ta­

ble.

Ennov InSight RIM 7.3 Release Notes

Cumulative

Database Columns Added: Ennov InSight

7.3.3

Database Columns Changed: Ennov InSight 7.3.3

The following Database fields, columns and tables were modified in this release.

UI Field Name
Database Table

Name

Database

Column Name

Database

Column Size

Old

Database

Column Size

New

Description

Manufactured

Item

Characteristics

/Description

MGR.MANUFACT 

URED_ITEM

MANUFACTURE 

D_ITEM
VARCHAR

2(500)

VARCHAR 

2(4000)
The column size

is changed to

VARCHAR

2(4000).

Database Columns Removed: Ennov InSight 7.3.3

UI Field Name
Database Table

Name

Database Column

Name

Database Col­

umn Type and 

Size

Description

N/A
RAWSTAGE.ENTIT

Y_INSTANCE_FIEL

D_VALUE

CONVERTED_VALU E CLOB
The new

CONVERTED_VALUE

column is added to the 

RAWSTAGE.ENTITY_IN 

STANCE_FIELD_VALUE ta­

ble.

The following Database fields, columns and tables were removed in this release.
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UI Field

Name

Database Table Name Database Column Name
Database

Column

Type and

Size

Description

N/A RAWSTAGE.ENTITY_INS 

TANCE_FIELD_VALUE

TEXT_VALUE CLOB
The TEXT_VALUE column is 

deleted from the

RAWSTAGE.ENTITY_INS 

TANCE_FIELD_VALUE table.

N/A RAWSTAGE.ENTITY_INS 

TANCE_FIELD_VALUE

DATE_VALUE CLOB
The DATE_VALUE column is 

deleted from the

RAWSTAGE.ENTITY_INS 

TANCE_FIELD_VALUE table.

Ennov InSight RIM 7.3 Release Notes

Cumulative Database Columns Changed: Ennov

UI Field

Name

Database Table Name Database Column Name
Database

Column

Type and

Size

Description

N/A RAWSTAGE.ENTITY_INS 

TANCE_FIELD_VALUE

LONG_VALUE CLOB
The LONG_VALUE

column is deleted from the

RAWSTAGE.ENTITY_INS 

TANCE_FIELD_VALUE table.

N/A RAWSTAGE.FIELD_DEFI 

NITION

FIELD_TYPE_ID CLOB
The FIELD_TYPE_ID column 

is deleted from the
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RAWSTAGE.ENTITY_FIEL 

D_DEFINITION table.

N/A RAWSTAGE.FIELD_TYPE N/A CLOB
The

RAWSTAGE.FIELD_TYPE ta­

ble is deleted.

N/A MGR.PDS_PACKSET_DE 

TAIL_CHANGE

COMP_QUANTITY_UOM 

_TYPE_ID

NUMBER
The unused

COMP_QUANTITY_UOM_

TYPE_ID column is

deleted from the

MGR.PDS_PACKSET_DET 

AIL_CHANGE table to re­

move the deprecated PDS 

Packaging Details

entity fields

N/A MGR.PDS_PACKSET_DE 

TAIL_CHANGE

COMP_QUANTITY_UOP_ 

TYPE_ID

NUMBER
The unused

COMP_QUANTITY_UOP_T

YPE_ID column is

deleted from the

MGR.PDS_PACKSET_DET 

AIL_CHANGE table to re­

move the deprecated PDS 

Packaging Details

entity fields

UI Field

Name

Database Table Name Database Column Name
Database

Column

Type and

Size

Description
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N/A MGR.PDS_PACKSET_DE 

TAIL_CHANGE

COMP_QUANTITY_VALU 

E
NUMBER

(24,12)

The unused

COMP_QUANTITY_VALUE

column is deleted from the

MGR.PDS_PACKSET_DET 

AIL_CHANGE table to re­

move the deprecated PDS 

Packaging Details

entity fields

N/A MGR.PDS_PACKSET_DE 

TAIL_CHANGE

CONTAINS_DI_PACKA 

GE_FLAG
VARCHAR

2 (1)

The unused

CONTAINS_DI_PACKAGE

_FLAG column is deleted 

from the

MGR.PDS_PACKSET_DET 

AIL_CHANGE table to re­

move the deprecated PDS 

Packaging Details

entity fields

N/A MGR.PDS_PACKSET_DE 

TAIL_CHANGE

PACKAGE_DISCONTIN 

UE_DATE

DATE
The unused

PACKAGE_DISCONTINUE

_DATE column is deleted 

from the

MGR.PDS_PACKSET_DET 

AIL_CHANGE table to re­

move the deprecated PDS 

Packaging Details

entity fields

Ennov InSight 7.3.4 Release Notes
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Ennov InSight 7.3 COB and Known Issues
For Clarification of Behavior (COB) and Known Issues, see: COB  and Known Issues  topics under Ennov InSight 7.3 

Release Notes (Cumulative)

https://help-insight.ennov.com/CalyxRIM_7.3/ReleaseNotes/clarification_of_behavior_ennov_insight_7_3.html
https://help-insight.ennov.com/CalyxRIM_7.3/ReleaseNotes/known_issues.html


Chapter 6. Ennov InSight 7.3.4 Release Notes
The Release Notes contain information about updated files, new functionality, resolved issues, and any open issues 

or workarounds in this release of Ennov InSight 7.3.4.

The details in these Release Notes supersede all similar details that appear anywhere else in this release of the 

product or its other documentation.

eCTD 4.0

Ennov InSight 7.3.4 introduces the following enhancements for eCTD 4.0:

• In the forward compatibility assembly, the functions on leafs will be the same as in eCTD 3.2.

• Leafs migrated with forward compatibility are published with a different leaf reference format.

• For forward compatibility, eCTD 4.0 leaf now includes the reference to the eCTD 3.2 leaf.

• Envelope field values and sender-defined keywords are automatically migrated from the submitted 3.2 

assembly to the working 4.0 assembly.

• The sender-defined keywords are created from the text values in metadata.

• The envelope fields are populated automatically in some cases.

• After making any changes to the Sender-defined Keywords, the Sender-defined Keywords tab now remains 

available on the Application Attributes page. This enhancement eliminates the need to navigate to the Sender-

defined Keywords tab.

• Publishing of JP eCTD 4.0 submissions is improved in this release.

• When a whole module node is added and the Create eCTD Wizard is used, the repeatable folders are no longer 

sorted. The sub-nodes of repeatable folders, however, are sorted.

Regulatory Updates

Ennov InSight 7.3.4 now introduces Ukraine (UA) v1.0 submissions:

For more information about new UA values, extensions, and rules, see

• Ennov InSight Data Migration 7.3 > Ennov InSight 7.3.4 Updates

• Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Filing Types > eCTD Filing Types for UA v1.0

• Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Procedure Types

• Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Country Values T-Z

• Ennov InSight Administration 7.3 > Assembly XML Specification > Extensions > Groups of Extensions by 

Version and Country

• Ennov InSight Administration 7.3 > Assembly XML Specification > Extensions > Folder Extensions > envelope-

ua > Envelope-ua v1.0

• Ennov InSight Administration 7.3 > Administrative Activities > Manage eCTD and eCTD 4.0 Templates > eCTD 

Templates

• Ennov InSight Publishing 7.3 > Use eCTD Templates > eCTD and NeeS Template Files

• Ennov InSight Publishing 7.3 > Use eCTD Templates > Mapped eCTD Template Profiles
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• Ennov InSight Publishing 7.3 > Extended Attributes Name, Type, and Version

• Ennov InSight Publishing 7.3 > Submissions > Create eCTD Wizard > Ukraine-v1.0

• Ennov InSight Publishing 7.3 > Extension Type and Usage > Extension Type: Regional Folders > Ukraine

Ennov InSight 7.3.4 now introduces Australia (AU) v3.2 submissions:

For more information about new AU values, extensions, and rules, see:

• Ennov InSight Data Migration 7.3 > Ennov InSight 7.3.4 Updates

• Ennov InSight Administration 7.3 > Assembly XML Specification > Extensions > Groups of Extensions by 

Version and Country

• Ennov InSight Administration 7.3 > Assembly XML Specification > Extensions > Folder Extensions > m1-au 

v3.2

• Ennov InSight Administration 7.3 > Administrative Activities > Import eCTD Applications > Prepare for Bulk 

eCTD Import

• Ennov InSight Administration 7.3 > Administrative Activities > Manage eCTD and eCTD 4.0 Templates > eCTD 

Templates

• Ennov InSight Administration 7.3 > eCTD Codes > eCTD Codes for Filing Types > AU v3.2

• Ennov InSight Publishing 7.3 > Use eCTD Templates > eCTD and NeeS Template Files

• Ennov InSight Publishing 7.3 > Extended Attributes Name, Type, and Version

• Ennov InSight Publishing 7.3 > Use eCTD Templates > Mapped eCTD Template Profiles

• Ennov InSight Publishing 7.3 > Extension Type and Usage > Extension Type: Regional Folders > Australia

Ennov InSight 7.3.4 now supports Centralised Procedure for West African Health Organization (WAHO) v1.0 

submissions:

For more information about new WAHO values, extensions, and rules, see:

• Ennov InSight Data Migration 7.3 > Ennov InSight 7.3.4 Updates

• Ennov InSight 7.3 Administration > eCTD Codes > eCTD Codes for Procedure Types > WAHO

• Ennov InSight 7.3 Administration > Application Maintenance > Application Maintenance: Application Values > 

Procedure Type Values

• Ennov InSight 7.3 Registration > Applications

• Ennov InSight 7.3 Registration > Applications > Create Application Wizard > CTA, CTR and IND Application

• Ennov InSight 7.3 Registration > Applications > Create Application Wizard > CTA, CTR and IND Application > 

Create a CTA, CTR or an IND Application

• Ennov InSight 7.3 Registration > Global Project Planning > Create a Project > New Applications Package Set 

Registration Project > Create a New Applications Package Set Registration Project

• Ennov InSight 7.3 Registration > Global Project Planning > Create Product Registrations for Project Events

• Ennov InSight 7.3 Registration > Applications > Copy Applications

• Ennov InSight 7.3 Registration > Applications > Application Countries > Remove Application Countries

• Ennov InSight 7.3 Registration > Events > Event-Country Statuses, Actual Dates, Projected Dates, and Lead 

Times
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• Ennov InSight 7.3 Publisher > Ennov InSight Publishing

• Ennov InSight 7.3 Publisher > Create Submission Wizard > Major Update Submission

• Ennov InSight 7.3 Publisher > Create Submission Wizard > Initial Application Submission

• Ennov InSight 7.3 Publisher > Create Submission Wizard > Initial Application Submission > Initial Application 

Submission Attributes

• Ennov InSight 7.3 Publisher > Create Submission Wizard > Major Update Submission

• Ennov InSight 7.3 Publisher > Create Submission Wizard > Amendment Submission > Amendment 

Submission Attributes

Common Enhancements

For better search and selection capability, an improved version of Product Selection widget is included in the Create 

Submission and GPP wizards.

IDMP Updates

To comply with the latest EMA IDMP implementation Guide (Chapter 2 version 2.2) and also improve the user 

experience, Ennov InSight now includes various updates for IDMP data capture:

• The following fields have been added to the Pharmaceutical Product Substance and Active Ingredient entities:

◦ Origin of Substance

◦ Composition Grouping Description

• Ability to create same Substance value with the Same Substance Name and Type and different Composition 

Grouping Description field.

• By default, the Origin of Substance and Composition Grouping Description fields are hidden on the PDS  > 

Active Ingredient Detail  and PDS  > Substance Detail  pages.

• The Manufacturing Authorisation Reference Number under Data Administration > Manufacturer is enabled for 

extra fields functionality. Also, new Function Types, Substances and Status Types fields have been added on 

the Manufacturing Authorisation Reference Number.

• It is now possible to use RMS mapping for Data Administration > File Identifier Type Values to RMS Master 

File Identifier Type list.

• It is now possible to edit the Confidentiality Indicator under Data Administration > Manufacturer Values > 

Global Product Details.

• The new field Required for IDMP?  is now included for all PDS > Manufacturer Details.

• The field type for Medicinal Product Names  > Full Name  is changed from Text field to Text area. This allows 

more than 4000 characters to be entered for the Medicinal Product Names  > Full Name  entity.
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• The Manufacturer value now displays as a concatenation of Manufacturer Name  + Address Line  + Country 

Code  + (Location ID, when associated to OMS).

• For a Registration Package Set entity, the field Legal Status of Supply  is moved from Registration Package 

Set Country  to Registration Package Set.

• For the following entities, new fields have been added for Presentation Strength and existing fields have been 

modified to comply with EMA's implementation guide for IDMP for the following entities:

◦ Component Active Ingredient

◦ Reference Active Ingredient

◦ Manufactured Item Active Ingredient

◦ Reference Active Ingredient

◦ Pharmaceutical Product Active Ingredient

◦ Reference Active Ingredient

◦ Product Details Set Active Ingredient

◦ Manufactured Item Substance

◦ Reference Substance

◦ Pharmaceutical Product Substance

◦ Reference Substance

◦ Product Detail Set Substance

◦ Product Details Flu Strain

For more information about about the new fields added, see the Presentation Strength  section under Entity Fields, 

Columns and Options Added: Ennov InSight 7.3.4

For more information on the changes made to the existing fields, see the Presentation Strength  section under Entity 

Fields, Columns and Options Updated: Ennov InSight 7.3.4

• For the MI Quantity Unit and Device Quantity Unit fields under PDS Packaging Details, values are shown from 

both the Unit of Presentation  and Unit of Measurement  Data Administration lists.

• The heirarchy for PMSID is updated based on IDMP specification changes. In addition, the IDMP tab on the 

Application Attributes page is updated..

• For all Application Procedure Types, the new field Package PMSID is included for Registration Package Set.

• To prepare for IDMP, the Associate Term icon is available on Data Administration > Substance Values and 

allows SMS values to be associated.

• For Packaging PDS Detail, the new field Parent Package is included with a logic. For more information, see 

Entity Fields, Columns and Options Added: Ennov InSight 7.3.4.

Publishing

When using the Remove Submissions from Lifecycle to this Sequence option to remove multiple sequences from 

lifecycle, the confirmation message now specifies the number of sequences that will be removed.
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Registration

• It is now possible to disassociate multiple Change Details from an Event simultaneously.

XEVMPD

• The new option Full Product Presentation under the same Registration per each Package Set is used  is now 

available to create a copy of the original Full Product Presentation for each Package Set selected under the 

same Registration. Using this option does not update the Package Description  field.

• Full Product Presentation entity

◦ Country field on Full Product Presentation is hidden OOTB now, same as in the Copy FPP wizards.

◦ The new field MAH/Organisation Transferred To  is available when Authorisation Status Not Valid - 

Superseded by Marketing Authorisation Transfer  is selected for FPP entity.

▪ XEVMPD Submission Wizard is updated to reflect those changes to include new tag to the 

XML structure.

• The Copy FPP wizard is enhanced to copy fields that were empty.

API

It is now possible to search by substanceReference and manufacturers fields using the API query endpoint.

New in Ennov InSight 7.3.4: Common Functionality
This table shows new features and enhancements of Ennov InSight 7.3.4 functionality.

IDMP

Affected Area Update Benefit

Entities
The following new fields are added 

for Manufactured Item and Pharma­

ceutical Product Active Ingredient 

and Substance:

• Origin of Substance

• Composition Grouping De­

scription

To support IDMP data capture.

Entities On the pages listed below, the manu­

facturer value now displays as a con­

catenation of Manufacturer Name 

+ Address Line  + Country Code  + 

(Location ID  (when associated to 

This enhancement enables a user 

to select the correct manufacturer 

when preparing for IDMP submis­

sion.
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Affected Area Update Benefit

OMS)). The OMS Status is added if 

not 'Active'.

• GPP: Update PDS

• Application History Query

• Application QC Status History 

Report

• List of Active Ingredient Man­

ufacturers

• List of Active Ingredient 

Function Manufacturers

• List of Active Ingredient Ma­

terial Manufacturers

• List of Excipient Manufactur­

ers

• List of PDS Manufacturers

• List of Component Manufac­

turers

• List of Package Set Manufac­

turers

New in Ennov InSight 7.3.4: XEVMPD
This table shows new features and enhancements of Ennov InSight 7.3.4 functionality.

Affected Area Update Benefit

Entity The new wizard flow Full Product 

Presentation under the same Regis­

tration per each Package Set is used 

is now available for each Package 

Set.

This new option allows you to cre­

ate a copy of the original Full Prod­

uct Presentation for each Package 

Set selected under the same Regis­

tration..

Resolved Issues: Ennov InSight 7.3.4
The following issues that were reported to Technical Support have been resolved. Issues are listed in descending 

order by their tracking numbers. Customer incident numbers that were recorded when the issues were reported are 

included in brackets [#####] following the tracking number.

If an issue was resolved in a previously released sub-minor build, that build number is included.
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Common

Issue Sub-Minor Build Description

DE32075 Without the NOT DEFINED Country rights, trying to delete an applica­

tion that had a submission in the lifecycle resulted in an error mes­

sage. This issue is resolved. Now, you can delete an application with 

a submission in the lifecycle even without the NOT DEFINED Country 

rights.

DE32055;

[TASK1344819]

The override to hide or rename failed for the Create Application label 

in the Wizards menu. This issue is resolved. Now, the Create Appli­

cation label can be hidden or renamed using the override option.

DE31886
If the Manufacturing Authorisation Reference Number, under Data 

Administration > Product Detail Set

Maintenance > Manufacturer Values > Manufacturer, was updat­

ed through API, the Effective Date field was empty. This issue is re­

solved.

Now, the Effective Date field contains the correct date.

DE31480
API request failed to update the following fields under Data Adminis­

tration > Product Detail Set Maintenance >

Manufacturer > Manufacturing Authorisation Reference Number:

— Effective Date

— Country

— Regulatory Agency

This issue is resolved. Now, all the fields are updated when using the 

API.

Resolved Issues: Ennov InSight 7.3.4

IDMP

Issue Sub-Minor Build Description

DE32277 When making a POST request to delete the Origin of Substance da­

ta administration value, the following error was displayed in the Re­

sponse. This issue is resolved. Now, no error is displayed When 
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making a POST request to delete the Origin of Substance data ad­

ministration value.

New in Ennov InSight 7.3.4: Common Functionality

Entity Fields

Entity Fields, Columns and Options Added: Ennov InSight 7.3.4

The following tables describe fields and columns that were added in this release.

PDS Manufacturer

Field/Column/ 

Option Name

Field Type Description Business Rules

Required for IDMP? Dropdown The Required for IDMP? 

field is now included for 

PDS Manufacturer Details.

To conform to the latest 

IDMP specification, the Re­

quired for IDMP? field is 

now included for PDS Man­

ufacturer.

Manufactured Item and Pharmaceutical Product

Field/Column/Op­

tion Name

Field Type Description Business Rules

Origin of Substance

Composition Grouping De­

scription

Dropdown
These fields are included 

for the following entities:

• Manufactured Item 

Active Ingredient

• Manufactured Item 

Substance

• Pharmaceutical 

Product Active In­

gredient

• Pharmaceutical 

Product Substance

To conform to the latest 

IDMP specification, these 

fields are now included.

Presentation Strength

Field/Column/Option Name Field Type Description Business Rules
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Presentation Single/Low 

Limit Denominator Value

Number

Presentation Single/Low 

Limit Denominator  -  Unit of 

Presentation/Measurement

Drop-down

Presentation High Limit De­

nominator Value

Number

Presentation High Limit De­
nominator  -  Unit of Presen­

tation/Measurement

Drop-down

These Presentation Strength 

fields are newly added for 

the following entities:

• Component Active 

Ingredient

• Reference Active In­

gredient

• Manufactured Item 

Active Ingredient

• Reference Active In­

gredient

• Pharmaceutical 

Product Active Ingre­

dient

• Reference Active In­

gredient

• Product Details Set > 

Active Ingredient De­

tail

• Manufactured Item 

Substance

• Reference Sub­

stance

• Pharmaceutical 

Product Substance

• Reference Sub­

stance

• Product Detail Set > 

Substance Details

These new fields are 

added to comply with 

EMA's ISO standards for 

IDMP

Medicinal Product Identifier (MPID)

Field/Column/Op­

tion Name

Field Type Description Business Rules

PMSID Drop-down For CP Application Proce­

dure Type, the new field 

PMSID  is included for Med­

icinal Product and shows a 

concatenated value of PMS 

and EU or EEA Country.

This new field is added 

to comply with EMA's ISO 

standards for IDMP.
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Packaged Medicinal Product Identifier (PCID)

Field/Column/Op­

tion Name

Field Type Description Business Rules

PMSID Drop-down For CP Application Proce­

dure Type, the new field 

PMSID  is included for 

PMSID and shows a con­

catenated value of PMS 

and EU or EEA Country.

This new field is added 

to comply with EMA's ISO 

standards for IDMP.

MPID Drop-down Shows the MPID assigned 

to PMSID.

This new field is added 

to comply with EMA's ISO 

standards for IDMP.

Product Management Service Identifier (PMSID)

Field/Column/Op­

tion Name

Field Type Description Business Rules

PMSID Country Drop-down For CP Application Proce­

dure Type, selecting PMSID 

shows the EEA Country val­

ue under PMSID Country.

This new field is added to 

suport IDMP data capture.

Registration Package Set

Field/Column/Op­

tion Name

Field Type Description Business Rules

Legal Status of Supply Drop-down This option is available in 

the Registration Package 

Set Country for a Registra­

tion Package Set entity.

This option is introduced 

to conform to the require­

ments of the health author­

ities.

Package PMSID Text For all Application Proce­

dure Type, the text field 

Package PMSID is added 

to the Registration Pack­

age Set.

This new field is added to 

comply with EMA's Implen­

tation Guide for IDMP.

Packaging PDS Detail
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Field/Column/Op­

tion Name

Field Type Description Business Rules

Parent Package Text This field is included for 

Packaging PDS Detail with 

the following logic:

1. List in Compo­

nent Packaging - 

From same com­

ponent: <Compo­

nent name> + <PDS 

packaging Catego­

ry> + <PDS Packag­

ing Type> defined 

(but not self).

2. List in Packset 

Packaging - On the 

packset level: all 

"Packset " + <PDS 

packaging Catego­

ry> + <PDS Packag­

ing Type> defined 

(but not self)

This new field is added 

to comply with EMA's ISO 

standards for IDMP.

Change Details

Field/Column/Op­

tion Name

Field Type Description Business Rules

Change Details Check box This option is available on 

the Change Details tab for 

an Event.

This feature allows you to 

simultaneously disassoci­

ate multiple Change Details 

and thereby enhances effi­

ciency when working with 

Events and Change Details.

Full Product Presentation
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Field/Column/Op­

tion Name

Field Type Description Business Rules

MAH/Organisation Trans­

ferred To

Drop-down The option is available for 

Authorisation Status when 

Not Valid - Superseded by 

Marketing Authorisation 

Transferis selected for FPP 

entity.

This new option is intro­

duced to reflect changes to 

include new tag to the XML 

structure.

Full Product Presentation 

under the same Registra­

tion per each Package Set

Check box This option is available in 

the Copy Full Product Pre­

sentation wizard.

This new option allows you 

to create a copy of the orig­

inal Full Product Presenta­

tion for each Package Set 

selected under the same 

Registration.

Entity Fields, Columns and Options Updated: Ennov InSight 7.3.4

The following tables describe fields, columns and options that were modified in this release.

Medicinal Product Name

Field/Option

Name

Field Type Description Business Rules

Full Name Text The field type is changed 

from Text to Text area for 

Medicinal Product.

The change allows more 

than 4000 characters to be 

entered for the Medicinal 

Product name.

PDS Component

Field/Option

Name

Field Type Description Business Rules

Origin of Substance

Composition Grouping De­

scription

Text
By default, these fields are 

hidden on the PDS Com­

ponent  > Active Ingredient 

Details  and PDS  Compo­

These fields are hidden as 

they are available now on 

Pharmaceutical Product 

and Manufactured Item.
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Field/Option

Name

Field Type Description Business Rules

nent  > Substance Details 

pages.

Presentation Strength

The table below provides details of the changes made to the Presentation Strength fields to conform to EMA's 

requirements. For a list of entities with changes to Presentation Strength fields, see IDMP Updates section in the 

Ennov InSight 7.3.4 Release Notes topic.

Existing Field Name Existing Field Type Change New Field Name New Field Type

Concentration Mea­

sure Type

Drop-down Field name changed Strength (Presenta­

tion) Quantity Opera­

tor

Drop-down (no 

change)

Presentation Single 

or Low Limit Numera­

tor Value

Text
Field name and type 

changed

Presentation Sin­

gle/Low Limit  -  Nu­

merator Value

String

Presentation Single 

or Low Limit Unit of 

Measurement

Drop-down Field name changed
Presentation Sin­

gle/Low Limit Numer­
ator - Unit  of Mea­

surement

Drop-down (No 

change)

Presentation Single 

or Low Limit Unit of 

Presentation

Drop-down Field name changed

This field is hidden by 

default.

DP Presentation Sin­

gle or Low Limit Unit 

of Presentation

Drop-down (No 

change)

Presentation High 

Limit Numerator Val­

ue

Text Field name and type 

changed
Presentation High 

Limit Numerator Val­

ue

String

Presentation High 

Limit Unit of Mea­

suremen

Drop-down Field name changed
Presentation High 

Limit Numerator  - 
Unit of Measurement

Drop-down (no 

change)
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Existing Field Name Existing Field Type Change New Field Name New Field Type

Presentation High 

Limit Unit of Presen­

tation

Drop-down Field name changed.

This field is hidden by 

default.

DP Presentation High 

Limit Unit of Presen­

tation

Drop-down (no 

change)

Packaging PDS Detail

Field/Option

Name

Field Type Description Business Rules

MI Quantity Unit and De­

vice Quantity Unit

Text Values from both Unit of 

Presentation  and Unit of 

Measurement  Data Admin­

istration are displayed for 

MI Quantity Unit.

The change is made to 

support IDMP data cap­

ture.

Substance Values

Field/Option

Name

Field Type Description Business Rules

Associate Term Text
SMS values may be as­

signed under Data Admin­

istration > Substance Val­

ues > SMS tab.

The change is made to 

support IDMP data cap­

ture.

Device Quantity Unit

Field/Option Field Type Description Business Rules

Device Quantity Unit Text The field Device Quantity 

Unit of Presentation is now 

renamed to Device Quan­

tity Unit and shows values 

from Unit of Presentation 

Values and Units of Mea­

surement.

The change is made to 

comply with EMA's imple­

mentation of the ISO stan­

dards for IDMP.

Confidentiality Indicator
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Field/Option Field Type Description Business Rules

Confidentiality Indicator Text The Confidentiality Indica­

tor value under Data Ad­

ministration > Manufactur­

er Values > Global Product 

Details can now be modi­

fied.

The change is made to 

comply with EMA's imple­

mentation of the ISO stan­

dards for IDMP.

XEVMPD

Field/Option

Name

Field Type Description Business Rules

Country Drop-down This option is hidden by de­

fault.

This change is introduced 

to comply with EMA's re­

quirement and enhance 

user experience.

Entity Fields, Columns and Options Removed: Ennov InSight 7.3.4

The following table describes fields, columns and options that were removed in this release.

Medicinal Product Identification (MPID)

Field/Column/Option 

Name

Field 

Type
Description Business Rules

Device Quantity Unit of 

Measurement

Text This field is removed by 

default.

This change is made to comply with EMA's implementa­

tion of the ISO standards for IDMP

Country Drop-

down

The Country  field is hid­

den by default.

This change is made to comply with EMA's implementa­

tion of the ISO standards for IDMP.

Registration Package Set Country

Field/

Column/Option 

Name

Field 

Type
Description Business Rules

Legal Status of 

Supply

Drop-

down

This field under Registration Package Set Country 

is removed by default.

This change is made to support 

IDMP data capture.



Chapter 7. Clarification of Behavior: Ennov InSight 7.3
This section provides an explanation of functionality that may be interpreted as an issue, but is in fact working as 

designed.

Ennov InSight : Common

Issue Affected Area Description

DE32324 N/A
Veeva SSO does not work some times if the Ennov InSight user cre­

dentials does not match the Federated User for Veeva SSO.

Workaround: Make multiple Microsoft accounts on the browser. You 

will be prompted to select the appropriate account to log on.

N/A N/A
After migrating to Ennov InSight 7.3, the following user settings are 

reset to default for the migrated users.

— Assembly tree width

— Product Details Set tree width

— Home page side panels width and show/hide condition

— Home page widgets show/hide condition

— Columns width

— Columns order

— Columns sort order

— Columns show/hide condition

— DMS Browse window size

N/A N/A After migrating to Ennov InSight 7.3, Public or Private queries saved 

in the Ennov InSight 6.2 query list will not be available in the Ennov 

InSight 7.3 query list for the migrated and newly added users.

N/A Assembly Performing any action from Ennov InSight 6.2 CHF 1 against a Vee­

va repository on limited release version 18R2.2 will result in an ex­

ception caused by an unexpected error response from Veeva Vault. 

If you experience this issue, please contact Veeva Support.

Issue Affected Area Description

https://support.veeva.com/hc/en-us
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N/A N/A If you are using network security products to scan your local intranet 

hosts for vulnerabilities, be aware that these products have a specif­

ic scan used against a JBoss server at TCP/IP port AJP/8009. Scan­

ning the Ennov InSight server with a network security product will 

cause an outage, requiring a restart. To avoid issues caused by net­

work security scanning products, see Firewall Rule for TCP_IP Port 

AJP_8009  in the Ennov InSight Installation Guide.

DE30854
Entity History

Query

If selected ATC is removed, the Entity History Query > Registered 

ATC Audit Details query shows new row with D

(Delete) action instead of both D and I (Insert). If multiple ATCs are 

removed, rows with D action as many as the number of ATCs re­

moved are shown in the query.

26740 N/A With the value for user.device.limit set to 1 in the insight.var file, 

when a user is logged on to InSight on device one, logging on to a 

second device terminates the InSight session on device one. How­

ever, refreshing the page on device one displays the InSight Home 

page. This is because of the Azure SSO functionality.

26727 N/A When a user is not included in the mapping list during the migration 

process, attempting to reassociate the user with a group can cause 

an “Invalid Reference” error. The error indicates the user profile is 

corrupted and Azure AD does not recognize it for synchronization.

26518;

[INC0028282,

CS0199557]

N/A Selecting documents in the Browse Documents > Assign Document 

window sends the Browse Documents  window to the background 

(behind the Assembly window), making a user activate the window 

for subsequent document assignment.

26418 N/A Duplicating Browser Tabs: Prior to Ennov InSight 6.2 CHF 3, dupli­

cating a browser tab of an active Ennov InSight session DID NOT re­

quire login for the duplicated session created on the new tab. From 

Ennov InSight 6.2 CHF 3 onward, duplicating a browser tab of an ac­

tive Ennov InSight session WILL require login for the duplicated ses­

sion created on the new tab.

Ennov InSight Publisher

Issue Affected Area Description
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N/A
Assembly,

Technical

Administration

When an assembly is created from an assembly file, the locations in­

cluded in the assembly file that do not match the repositories in En­

nov InSight Technical Administration will not be saved.

DE32135 Assembly After creating an EU 3.0.3 working assembly using Create eCTD wiz­

ard, when the eu-3-0-1 XML Definition is replaced with eu-3-1, the 

Submission Unit Type field cleared on the envelope\s attributes.

When publishing, a file name or a server name or, a file path should 

not exceed the Windows file system limit, which is 260 characters.

Note:   It is highly recommended to consider the file name length 

from DMS as long file names can cause issues. See Special Char­

acters.

DE31682 Assembly

DE26775
Assembly,DMS

Browse,

Technical

Administration

The attempt to log in to Veeva from DMS Browse using SSO profile 

results in an error message.

DE30272 Assembly It is not possible to download output file for published reference leaf 

using the View File option.

DE28529
Data

Administration

(SPOR Master

List)

For Ennov InSight 7.2, after the migrated build is installed, the values 

for the new SPOR Master Lists tables may not appear. This was de­

termined to be a data setup error.

This issue can be resolved by starting the synchronization process 

from the beginning. The architecture requires that the database and 

blob data are in sync and replacing a database or blob from another 

environment will cause issues.

Issue Affected Area Description

DE28147 Global Project 

Plan wizard

Using the Global Project Plan  wizard, if multiple applications are cre­

ated with the Create New Event for Existing CTA and/or IND Applica­

tion(s) option and then a sequence is created, the same Sequence 

Standard Type value will be applied to all the created sequences. 
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If there is at least one eCTD 4.0 sequence, under affected applica­

tions, the eCTD 4.0 will be the only available option.

DE27968 Assembly When the length of the output path exceeds the limit allowed by the 

operating system, publishing fails. This issue can be resolved by 

shortening the folder or leaf output names in assembly.



Chapter 8. Known Issues
The following general issues and module-specific issues were known at the time this document was published, 

but (due to time limitations) could not be included in the module-specific user documentation packaged with the 

software product.

Ennov InSight : Common

Issue Affected Area Description

240123 (Added on 

9th April, 2024)

Assembly When using the Prepare Cross Reference Leafs op­

tion, if there are multiple reference leafs pointing to 

the same target leaf, the checksum value is generat­

ed for one leaf only.

DE32002 (Added on 

the 29th of August, 

2024)

Assembly After assigning a document on folder from SMB, the 

PDF Exists value of the document is not set to Yes.

DE31898 (Added on 

the 28th of August, 

2024)

Reference Links If a Documentum folder has two documents with the 

same name and one of these documents have more 

than one version, creating a reference to this doc­

ument results in the reference created to the docu­

ment with only one version.

DE31882 (Added on 

the 29th of August, 

2024)

Assembly
Trying to rename a document previously assigned to 

an assembly results in a new name

not being displayed in the leaf after a document is 

reassigned.

DE30194 Entity History Trail After deleting an entity, the Entity Audit Trail query 

displays only a row with D (Delete) action instead of 

both U (Update) and D (Delete) rows. Details about 

performed action are now displayed in D (Delete) 

row.

DE29212 (Added on 

the 23rd of January, 

2023)

Application, Product, Product Family When performing the API Post request, an applica­

tion that does not have a product is not created un­

der a product family. Workaround: use override up­

dates to fix this issue.

DE28641 (Added on 

the 20th of October, 

2022)

Application, Products When all the products are disassociated on the Ap­

plication Attributes  page, the system allows disas­

sociation. No warning messages informing that at 
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least one product should be associated to the appli­

cation is displayed.

DE27749 (Added 

on the 19th of April, 

2022)

Application, Country
For individual users, when the Application Country 

Rights  for Product Families is set to All and Coun­

tries is set to any rights, navigating to a county from 

the Application Attributes > Countries tab results in 

an error.

Workaround: Set the Application Country Rights  for 

Product Families and Countries to

All .

DE29739 Application, Product Family, Create 

Submission wizard
The Create Submission wizard does not work for ap­

plications without products when selecting Major 

Update or Amendment options. When it is opened 

from:

— the Application Attributes  page, the error message 

is displayed.

— any other pages, for example: Home > Wizards > 

Create Submission, the applications with products 

can be only selected.

DE27309 (Added on 

the 12th of January, 

2022)

Update Product Details Sets, PDS, 

Substance
When you select Global Project Plan > Modify

Substance or Add Substance from Project

Attributes  page for the Update Product Details Sets 

project type, not all the fields are displayed in com­

parison to the Substance page in PDS.

26814 Publishing
Using Prepare for Publishing with the Prepare Cross 

Reference Leafs option selected results

in the Unable to extract checksum error

if there is a reference leaf to leaf published to

Documentum.
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26807 (Added on 

20th Aug 2021)

Assembly When updating a leaf in an assembly, selecting On­

Load for the Actuate option results in an error mes­

sage. This is because of the default security set­

tings. Workaround: Update the leaf using API.

26799 eCTD Import
After you use the Bulk eCTD Import for TW submis­

sion, the Job Status is set to Scheduled instead of 

Completed. This is because the twregional.xml file 

does not contain the application code.

Workaround: Use Import eCTD to Application instead 

of Bulk eCTD Import. See: Import eCTD to Applica­

tion.

26728 Global Project Plan wizard, PDS In the Global Project Plan  wizard, when modifying 

an active ingredient for a PDS the Withdraw Materi­

al that is already selected is not shown in the drop-

down list.

26699 Assembly
Ennov InSight can incorrectly send a

Native .PDF file to Ennov InSight Rendering for ex­

traction. Also, while a large file can fail extraction, it 

might not prevent successful publishing.

26637;

[INC0045216]

Administration In Data Administration, the Check for Datebased No­

tifications menu is not available on the Notification 

Specifications grid.

Ennov InSight Publisher

Issue Affected Area Description

DE32388 (Added on 

the 21st of January, 

2025)

Publishing eCTD 4.0: Working assemblies are not displayed in 

the Quick Search results.

DE32365 (Added on 

7th of December, 

2024)

Publishing After creating an assembly from an EU 3.1 assembly 

that is exported, the Submission Type and Submis­

sion Unit Type envelope values are not displayed.
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DE32346 (Added on 

19th of December, 

2024)

Publishing When importing an eCTD application having leafs 

with Replace, Append, and Withdraw lifecycle opera­

tion performed on them, the values for the following 

may be missing: Language, Application Version, Ver­

sion, Font Library, Role, Actuate, and Show.

DE32056 (Added on 

20th of September, 

2024)

Assembly Performance issue is experienced when using the 

Insert Volume functionality.

DE31961 (Added on 

the 21st of August, 

2024)

Assembly
When a document is assigned from the Secure

File System and then the Extract Document Data job 

is performed, editing the document from the Secure 

File System and performing the DMS Synchroniza­

tion results in the creation of two Extract Document 

Data jobs.

DE31940 (Added on 

the 16th of August, 

2024)

Assembly
Searching for a document to assign using Build 

Query results in an error.

Workaround: Form a search request without Build 

Query option.

DE31934 (Added on 

the 14th of August, 

2024)

Assembly
After the subsequent volume is inserted into the as­

sembly folder or deleted, the previous volume name 

changes to the default one.

Workaround: Update volume names manually.

DE31925 (Added on 

the 28th of August, 

2024)

Create eCTD wizard
It takes longer than expected to create a 1.1.5 folder 

using the Create eCTD  wizard.

Workaround: Create a folder manually or wait for a 

wizard to complete the folder creation.

DE31470 Publishing eCTD 4.0: After submitting the publish request with 

All Leaf Elements and XML options selected, the 

Publish Request window fails to close.
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DE30999 (Added on 

the 27th of Novem­

ber, 2023)

Assembly
eCTD 4.0: After a CV Profile is removed from the Edit 

Publishing Settings > CV Profiles > Selected section, 

some of the Sender-defined

Keyword values are not displayed on the Additional 

Information  page in the assembly folder.

Expected: All fields are displayed on the Additional 

Information  page.

The change of CV Profiles for the existing assembly 

is not supported.

DE30247 Assembly
After exporting an assembly to XML file,

Default Overlay For field does not contain Docu­

ments value. Adding the same value to a new as­

sembly created from XML file results in Invalid Refer­

ence error.

DE29906 Assembly
In the Working eCTD 4.0 assembly, when a duplicate 

folder or a reference leaf is created, the Document 

ID field fails to inherit the value in the duplicate refer­

ence leaf.

Workaround: After a duplicate reference leaf is creat­

ed, recreate it by using the option Convert

to Default Leaf first and then Convert to Reference 

Leaf.

DE29855 (Added 

on the 22th of May, 

2023)

Assembly After re-running the Refresh Tree operation, se­

quence assembly structure does not update. 

Workaround: Log out from your user account and log 

on again.

DE29521 (Added on 

the 23th of March, 

2023)

Assembly
In an assembly, the username format displayed 

when changing the user in the Owner field is incor­

rect. Instead of

firstname.lastname@calyx.ai, firstname.lastname is 

displayed.
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DE28539 (Added on 

the 28th of Septem­

ber, 2022)

Assembly
Operations with eCTD 4.0 assembly can fail if their 

processing time exceeds four minutes.

Workaround: In the assembly created, reduce the 

number of operated nodes to make the processing 

time faster.

DE27966 (Added 

on the 1st of June, 

2022)

Assembly
The published output files are not exported to Docu­

mentum repository if they have Chinese characters 

in the file name.

Workaround: rename files as per eCTD normalization 

rules before exporting output.

DE27958 (Added on 

1st of June, 2022)

Assembly
After publishing the China assembly, China symbols 

are present in the name of the STF

file. For example: stf- 4.2.1.1 药效学.xml

Workaround: rename files as per eCTD normalization 

rules before exporting output.

DE27442 (Added on 

the 9th of February, 

2022)

Assembly eCTD 4.0: After clicking Lock or Unlock on an as­

sembly folder or an assembly root, the Throbber icon 

used to indicate an action in progress does not ap­

pear and all the folder or assembly elements remain 

enabled.

20270;

[136797FW]

Assembly Links for External Bookmarks are incorrect for split 

documents in paper published output.

DE32383 (Added on 

the 16th of January, 

2024)

Data Administrator If the Display Name exceeds 1000 characters, it is 

not possible to create and update Senderdefined 

Keyword Value.

Ennov InSight Registrations

Issue Affected Area Description

DE31108 (Added on 

the 10th of January, 

2024)

Substance, Pharmaceutical Product
On the Medicinal Product Attributes >

Pharmaceutical Products tab, the
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Pharmaceutical Product Summary column displays 

the Range value from Concentration Measure Type 

and does not show all the reference active ingredi­

ents.

The column should display all the reference active 

ingredients while hiding the Range value.

Ennov InSight Outlook add-in

Issue Affected Area Description

DE26820 Outlook add-in form
You cannot attach the following items from an e-

mail in the add-in forms: — Contact - .vcf

— Calendar (Event) - .ics

— Outlook e-mails - e-mails without an extension (e-

mail chain, single e-mail, and composed e-mail)

DE26804 Outlook add-in form
When using the API GET request for retrieving the re­

cipients from Microsoft Graph, if the search criteria 

contains a space, the following error is shown: 500 

Internal Server

Error

DE26803 Outlook add-in form In the Add Notification Recipients field, it is not pos­

sible to delete any spaces.

DE26782 Outlook add-in form If more than 50 users try to submit a form, the sys­

tem fails and an error is displayed.

DE26781 Outlook add-in form When an API request with invalid product id is sent 

for CreateSubmissionAndReference, an incorrect er­

ror message is displayed.

DE26738 Outlook add-in form If Ennov InSight Outlook add-in fails to submit the 

forms, an incorrect error message is displayed.

DE26731 Outlook add-in form
An auto-populate functionality does not work for 

the Product field in the Ennov InSight Outlook add-in 

forms if the product name starts with an article. Ex­

ample: "The Product
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01", "A Product 123"

In the Ennov InSight Outlook add-in forms, the au­

to populate does not work for product unless more 

than 3 characters are typed.

DE26715 Tool Box and Activity History When using the Ennov InSight Outlook add-in desk­

top version on Windows 10, version 2004 and Out­

look version 1908, it is not possible to click the Ex­

port button on the Activity History Analysis  page.

DE26711 Add-in meta overrides Trying to change the Ennov InSight Outlook add-in 

icon takes longer time than expected.

DE26704 Outlook add-in form Empty text files cannot be attached using the 

Browse File button.

DE26703 Add-in meta overrides In the Ennov InSight Outlook add-in desktop version, 

even after restarting the Microsoft 365 Outlook, the 

system fails to override the "Liquent InSight" launch 

icon.

DE26702 Outlook add-in form
When trying to attach the files for the Ennov InSight 

Outlook add-in forms, ToolTips are not displayed for 

the following:

— Attach from email button

— Browse files button

— "No available items to attach"

ToolTip when all the attachments are already at­

tached

Ennov InSight Rendering

Issue Affected Area Description

DE26968

(Added on the

23rd of

December, 2021)

Assembly
The assembly files cannot be published to Documen­

tum if their size is 800 mb and more. The distribute 

job request fails.

Workaround: Ensure that the size of the assembly 

files is less than 800 mb.



Ennov InSight 7.3 Release Notes Cumulative  | 8 - Known Issues  | 153

DE28324;

[TASK0043134,

INC0109855]

(Added on the

12th of August,

2022)

Assembly Publishing to some printers may result in tab text 

misplacement.

DE26794 Assembly When eCTD assembly is published, the validation 

messages from the backbone generator are not dis­

played in Job Requests Details.
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